West Customer Service

West Case Notebook Assistance
If you have general or technical questions about West Case Notebook, call West LiveNote Customer Technical Support at 1-800-290-9378, Monday through Friday, 7:00 a.m. to 7:30 p.m. central time. You can also send an e-mail message to west.livenote@thomson.com.

Billing and Account Assistance
For billing and account assistance, call Customer Service at 1-800-328-4880 or e-mail customerservice@thomsonreuters.com. Billing and account assistance is also available online at west.thomson.com/support.

Reference Materials
To browse and order free West Case Notebook reference materials, visit west.thomson.com/support/user-guide/livenote-case-notebook.aspx. West Case Notebook also contains valuable online Help.

About This Guide
In this guide, the graphics and step-by-step instructions are based on using West Case Notebook. Because of the evolving nature of this technology, there may be changes to interfaces and functionality that are not reflected in this documentation.
## Contents

1 **INTRODUCTION** ................................................................. 1  
   File Types for Importing Transcripts ................................ 1  
   File Types for Importing Documents and Pleadings .............. 2  

2 **MANAGING CASES** .......................................................... 3  
   Creating a New Local Case ................................................. 3  
   Creating a New Case from an Open Case ............................... 4  
   Opening a Local Case .................................................... 4  
   Importing a Case .......................................................... 4  
   Opening a RealLegal Binder Case ....................................... 4  
   Accessing Secure Cases .................................................. 4  
   Accessing Secure Cases Through West LiveNote RAS ............ 6  
   Viewing a List of Favorite Secure Cases ............................. 7  
   Replicating Cases Offline and to the Network ....................... 7  
   Replicating a Case Offline .............................................. 7  
   Replicating a Case to the Network .................................... 8  
   Replicating Multiple Cases Offline ................................... 8  
   Replicating Multiple Cases to the Network ......................... 10  
   Changing Replication Options .......................................... 10  
   Creating a Case Report .................................................. 11  

3 **MANAGING TRANSCRIPTS** ................................................. 13  
   Importing a Transcript .................................................. 13  
   Opening an Existing Transcript ....................................... 14  
   Creating a Transcript Summary ....................................... 14  
   Creating a Transcript Summary Report ............................... 16  
   Opening a Transcript Summary Item ................................... 16  
   Deleting a Transcript Summary Item ................................... 16  
   Closing a Transcript .................................................... 16  
   Deleting a Transcript .................................................... 17  
   Printing a Transcript with Annotations .............................. 17  

4 **UPDATING TRANSCRIPTS** ............................................... 19  
   Starting the Updating Process .......................................... 19  
   Updating with a PTX or EXE File ....................................... 19  
   Updating with an ASCII File .......................................... 19  
   Updating with a PTF File .............................................. 20  
   Updating with a LEF File .............................................. 20  

5 **MANAGING DOCUMENTS** .................................................. 22  
   Importing a Document .................................................... 22  
   Importing Multiple Documents ......................................... 23  
   Importing Load Files ..................................................... 24  
   Sending Documents to West Case Notebook Using Windows Explorer .................................................................................................................... 26  
   Sending Documents to West Case Notebook from Microsoft Outlook ......................................................................................................................... 27  
   Opening an Existing Document ......................................... 28  
   Deleting a Document ....................................................... 28  
   Closing a Document ....................................................... 28
6 MANAGING PLEADINGS ................................................................. 29
Importing a Pleading ................................................................. 29
Sending Pleadings to West Case Notebook Using Windows Explorer ................................. 30
Sending Pleadings to West Case Notebook from Microsoft Outlook .................................... 31
Opening an Existing Pleading ................................................................... 32
Deleting a Pleading ........................................................................... 32
Closing a Pleading ........................................................................... 32

7 MANAGING RESEARCH ..................................................................... 33
Searching Westlaw ........................................................................... 33
Using WestFind&Print ........................................................................ 35
Sending a Westlaw Search Result to West Case Notebook .................................................... 35
Searching WestlawNext ....................................................................... 37
Sending a WestlawNext Research Document to West Case Notebook .................................. 39
Updating KeyCite Information .................................................................... 40
Sending Research Documents to West Case Notebook Using Windows Explorer ................ 40
Importing Research Documents ............................................................... 41

8 MANAGING KEY FACTS ...................................................................... 43
Creating a Key Fact ........................................................................... 43
Creating a Key Facts Report .................................................................. 44
Editing a Key Fact .............................................................................. 45
Deleting a Key Fact ............................................................................. 45
Closing the Key Facts Tab ..................................................................... 45
Sending Key Facts to Microsoft Word or Corel WordPerfect .................. 45
Sending Key Facts to West Case Timeline ........................................... 45
Saving Key Facts As a West Case Timeline File ........................................ 46

9 MANAGING CHARACTERS ................................................................. 47
Adding Characters .............................................................................. 47
Adding Characters Manually ................................................................ 47
Adding Characters Automatically ........................................................... 48
Adding CharacterS from a Smart Tags List ........................................... 49
Working with Aliases .......................................................................... 50
Retrieving a Character’s Profile from Westlaw ........................................ 51
Creating a Characters Report ............................................................... 52
Exporting Characters to a File .............................................................. 53
Editing a Character ........................................................................... 53
Deleting a Character .......................................................................... 53
Closing the Characters Tab ................................................................... 53

10 MANAGING OUTLINES .............................................................. 54
Creating an Outline ........................................................................... 54
Inserting Information into an Outline .................................................. 55
Typing Text in the Outline .................................................................... 55
Inserting Text from a Document .......................................................... 55
Inserting a Report .............................................................................. 55
Inserting Potential Exhibits ................................................................. 56
Inserting Transcript Questions ............................................................ 57
Inserting a Westlaw Document ............................................................. 58
Viewing Documents in an Outline ........................................................ 61
Printing an Outline ............................................................................ 61
Opening an Existing Outline ............................................................... 63
Contents

11 WORKING WITH ISSUES ......................................................... 64
Creating Issues ................................................................. 64
  Creating Sub-issues ......................................................... 64
Prioritizing Issues ............................................................. 65
Importing Issues ................................................................. 66
Exporting Issues ................................................................. 66
Creating an Issues Report ..................................................... 66

12 WORKING WITH ANNOTATIONS .............................................. 68
Adding an Issue Annotation Using the Main Menu Toolbar .......... 68
Adding an Annotation Using the Annotation Properties Dialog Box . 68
  Adding a Note to an Annotation .......................................... 69
  Adding an Issue to an Annotation ....................................... 69
  Adding a Key Fact to an Annotation .................................... 69
  Adding an Attachment to an Annotation ............................... 69
  Associating Video with an Annotation .................................. 69
Transferring Annotations .................................................... 69
Sending Annotations to Instant Messages .............................. 70
Editing Annotations ........................................................... 70
Deleting Annotations .......................................................... 70
Viewing an Annotation Attachment ...................................... 70
Creating an Annotations Report .......................................... 70
  Creating a Verbatim Digest Report ...................................... 72
  Creating a Notes Report ................................................... 72
  Creating an Attachments Report ........................................ 72

13 WORKING WITH FULL TEXT SEARCH ..................................... 73
Creating a Full Text Search .................................................. 73
Formatting a Full Text Search ............................................... 74
  Using the Root Expander .................................................. 74
  Using the Universal Character .......................................... 74
  Using Connectors .......................................................... 75
Creating a Search Report ..................................................... 75

14 WORKING WITH AUTO TAGS .................................................. 76
Creating Auto Tags ............................................................. 76
Managing Auto Tags ............................................................ 76
  Showing and Hiding Auto Tags .......................................... 76
  Deleting Auto Tags ........................................................ 76
Creating an Auto Tag Report ................................................ 77

15 WORKING WITH DATA GROUPS ............................................... 78
Creating a Data Group ........................................................ 78
Editing Data Groups ........................................................... 79
Using Data Groups in Reports .............................................. 79
Using Data Groups in Full Text Searches ................................ 79
Sorting by Data Groups ......................................................... 79

16 TRANSFERRING DOCUMENT TEXT .......................................... 80
Transferring Text of a Transcript ......................................... 80
Transferring Text of a Document or Pleading .......................... 80
1 Introduction

West Case Notebook is an electronic organizer and deposition tool for saving and working with important documents, research, and transcripts. With West Case Notebook you can

• track key facts and their related issues
• track the parties involved in the litigation
• import and convert key documents to text-searchable formats using optical character recognition (OCR) technology
• send research documents from Westlaw to a case file
• check KeyCite status
• create outlines and transcript summaries
• build issues databases by creating categories and highlighting text
• summarize issues by running reports
• copy text from a Westlaw document and paste the text along with the citation into a word-processing document
• connect to a deposition transcript in real time

File Types for Importing Transcripts
You can import the following types of transcript files into West Case Notebook:

• E-Transcript files (PTX or EXE)—transcript only format provided by court reporters; may include court reporter’s signature
• ASCII (text only) files—transcript only format
• Portable Transcript (PTF) files—used to move a transcript with annotations to another program that will accept that file type or another West Case Notebook or West LiveNote computer
• LiveNote Evidence Format™ (LEF™) files—contain the transcript with linked exhibit files; may contain synchronized video
• Publisher Bundle (bundle.xml) files—contain the transcript with linked exhibit files; may contain synchronized video
• E-Transcript Bundle (PTZ) files—created with West Publisher version 5 or later; contain the transcript with linked exhibit files; may contain synchronized video
• Extensible Markup Language (XML) files—contain the transcript with linked exhibit files; may contain synchronized video
• CT Summation (TRN) files
• Timaro Technologies Post-Production Time-Stamp (PTS) files
File Types for Importing Documents and Pleadings

You can import the following types of files for documents and pleadings into West Case Notebook:

- Images
  - TIF/TIFF (Tagged Image File Format)
  - BMP (Bitmap)
  - JPE/JPG/JPEG (Joint Photographic Experts Group)
  - GIF (Graphic Interchange Format)
  - PNG (Portable Network Graphics)
  - JFX
- PDF (Portable Document Format)
- DOC/DOCX (Microsoft Word file)
- WP/WPD (Corel WordPerfect file)
- MSG (Microsoft Outlook file)
- HTM/HTML (Hypertext Markup Language)
- PEX (LiveNote document file)
- TXT (plain text file)
- RTF (Rich Text Format)

An administrator can designate who can access the case file documents.

- Document review load files
  - CaseCentral ASCII Load File (TXT)
  - Concordance ASCII Load File (DAT)
  - IPRO ASCII Load File (LFP)
  - Lextranet ASCII Load File (TXT)
  - Opticon ASCII Load File (OPT)
  - Summation ASCII Load File (TXT)

Note: If your load file is not one of the types listed, you still may be able to import it using the Custom options or by using conversion tools available for free on the Internet.
Managing Cases

Creating a New Local Case

Cases in West Case Notebook can be created for one person to use (local cases), or they can be created through the West LiveNote Administration module to be available on a network so they can be shared (secure cases). Local cases can be imported through the West LiveNote Administration module to also make them shareable.

To create a new case, follow these steps:

1. Access West Case Notebook to display the Open Case dialog box (Figure 2-1).

![Figure 2-1. Open Case dialog box](image)

2. Click **New** to display the Save As dialog box.
3. Select the location to use for storage of the case; type the file name, e.g., smithjones, and click **Save**. The New Case Properties dialog box is displayed.
4. Type the name of the case, e.g., **Smith v Jones**, in the **Name** text box.
5. Click **OK**.

The case window, which lists all the documents for the case, is displayed (Figure 2-2).

![Figure 2-2. Case window](image)
CREATING A NEW CASE FROM AN OPEN CASE

To create a new case from an open case, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar and choose **Case** from the menu. The Save As dialog box is displayed.
2. Select the location to use for storage of the case; type the file name, e.g., *smithvjones*; and click **Save**. The New Case Properties dialog box is displayed.
3. Type the name of the case, e.g., *Smith v Jones*, in the **Name** text box.
4. Click **OK**.

Opening a Local Case

To open a case, choose **Open Case** from the File menu to display the Open Case dialog box. Select your case from the list and click **OK**.

Importing a Case

To import a case, complete these steps:

1. Click the **New** arrow, then choose **Case (from File)** from the menu. The Open dialog box is displayed.
2. Select your case and click **Open**. The Save As dialog box is displayed.
3. Type a name for the file in the **File name** text box.
4. Click **Save**. The message *Would you like to add the new case to your case list?* is displayed. Click **Yes**. The case is displayed in the case window.

Opening a RealLegal Binder Case

You can open a RealLegal Binder case, version 5 or later, in West Case Notebook. To open a RealLegal Binder case, complete these steps:

1. Choose **Open Case** from the File menu to display the Open Case dialog box.
2. Click **Add**. The Open dialog box is displayed.
3. Select the RealLegal Binder Case (PXL) file you want to import and click **Open**.
4. The message *This case was created with RealLegal Binder. It must be imported before it can be used. Do you want to continue?* is displayed. Click **Yes**. The Save As dialog box is displayed.
5. Type a name for the file in the **File name** text box and click **Save**. The case is listed in the Open Case dialog box.
6. Select the case and click **OK**.

**Note**  The RealLegal Binder case opens as a local case with no assigned users. For further information on the conversion of RealLegal Binder cases to West Case Notebook cases, see Appendix B.

Accessing Secure Cases

**Note**

- If you are working on a secure case with other users, all users must use the same version of West Case Notebook. For example, if a secure case is upgraded to West Case Notebook version 2.5, all users working on the case must use West Case Notebook version 2.5.
- If you are working in a West Case Notebook 2.5 case, then revert to using West Case Notebook version 1.0, you must manually rebuild the search index for the case. To rebuild the search index, choose **Advanced, Rebuild Search Index** from the Tools menu.

To access a secure case, complete these steps:
1. Access West Case Notebook. Or in an open case, choose Open Case from the File menu. The Open Case dialog box is displayed (Figure 2-3).

![Figure 2-3. Open Case dialog box](image)

2. Click Repositories. The Repositories dialog box is displayed (Figure 2-4).

![Figure 2-4. Repositories dialog box](image)

3. Select the repository that you want to log on to and click Logon. The Logon to [Repository Name] dialog box is displayed (Figure 2-5).

![Figure 2-5. Logon to [Repository Name] dialog box](image)

4. Type your username and the password that is assigned to you in West LiveNote Administration in the Username and Password text boxes.

5. Select the Remember my logon settings check box if you want West Case Notebook to remember your username and password.
6. Click **OK**. The Repositories dialog box is redisplayed (Figure 2-6).

![Repositories dialog box](image)

Figure 2-6. Repositories dialog box

7. Click **Close**. The Open Case dialog box is redisplayed with a list of the cases to which you are assigned (Figure 2-7).

![Open Case dialog box](image)

Figure 2-7. Open Case dialog box

**Note** Two types of case icons may be displayed:

- A brown case icon ( ) indicates a local case or a secure case that is currently being accessed through the network.
- A brown and blue case icon ( ) indicates a secure case that was replicated offline and is currently being accessed locally.

To view only secure cases, choose **List Cases by Repository** from the drop-down list at the top of the dialog box, then click the plus symbol (+) next to the repository containing the cases you want to view.

8. Select your case and click **OK**.

**ACCESSING SECURE CASES THROUGH WEST LIVENOTE RAS**

West LiveNote RAS (remote access server) provides remote access to your West Case Notebook cases via the Internet. When you access a case remotely, most of the features in West Case Notebook are available. When you finish working on a case, your changes are saved to the server. After you close a remote case, you must log on to another remote session to access the case again.

When you use West LiveNote RAS, you cannot:

- copy a case
- administer remote cases using West LiveNote Administration
- connect to Realtime

**Note** To connect to Realtime in a case you access through West LiveNote RAS, you must replicate the case offline.

To access a secure case through West LiveNote RAS, complete steps 1 through 8 above.
Viewing a List of Favorite Secure Cases

When you access secure cases in West Case Notebook, all of the cases to which you are assigned are listed in the Open Case dialog box. You can add one or more of these cases to your list of favorite cases, then view only those cases when you access West Case Notebook.

To view your list of favorite cases, complete these steps:

1. Access secure cases. The Open Case dialog box is displayed with the list of the cases to which you are assigned (Figure 2-8).

![Figure 2-8. Open Case dialog box](image)

2. Right-click the case you want to add to your list of favorite cases, e.g., *Clelland v Anderson*, and click *Add to My Favorite Cases*.

3. Choose *List My Favorite Cases* from the drop-down list at the top of the dialog box. Your list of favorite cases is displayed (Figure 2-9).

![Figure 2-9. List of favorite cases](image)

Replicating Cases Offline and to the Network

*Note* If you replicate a case offline on one computer and want to access the case via the network on a different computer, you must have a separate username assigned to you in the repository for each computer.

REPLICATING A CASE OFFLINE

You can work on a secure case off the network by replicating the case offline in West Case Notebook. To replicate a secure case that you are currently working on offline, complete these steps:
1. From the File menu, choose **Replicate Case Offline**. The Replication Wizard–Case Data dialog box is displayed (Figure 2-10).

![Figure 2-10. Replication Wizard–Case Data dialog box](image)

2. By default, all document types and data are selected. To exclude a document type from being replicated offline, clear its check box. To exclude particular data from the report, click the document type containing the data, then clear the check boxes for the data you want to exclude.

3. Click **Groups** to add the data you selected to a data group. The Data Groups dialog box is displayed. Select the group to which you want to add the data and click **OK**.

   **Note** You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see "Working with Data Groups" on page 78.

4. Click **Finish**. The Cases Replicated to Offline dialog box is displayed, informing you that the case was successfully replicated offline.

5. Click one of the following:
   - **Open Case**. The case is displayed in the left pane.
   - **Close**. The case is closed.

**REPLICATING A CASE TO THE NETWORK**

To replicate a case you are currently working on to the network, complete these steps:

1. From the File menu, choose **Replicate Case Online**. The Cases Replicated to Network dialog box is displayed.

2. Click one of the following:
   - **Open Case**. The case is displayed in the left pane.
   - **Close**. The case is closed.

**REPLICATING MULTIPLE CASES OFFLINE**

To replicate multiple cases offline, you must first change your replication options, then close West Case Notebook and select the cases you want to replicate offline. To replicate multiple cases offline, complete these steps:
1. Choose **Options** from the Tools menu. The Options dialog box is displayed.
2. On the Confirmation tab, select the **Replicate offline on closing West LiveNote** check box, then click **OK**.
3. Close West Case Notebook. The Replication Wizard–Cases dialog box is displayed (Figure 2-11).

![Figure 2-11. Replication Wizard–Cases dialog box](image)

4. By default, all the cases on the network that are assigned to you are selected. To exclude a case from being replicated offline, clear its check box.
5. Click **Next**. The Replication Wizard–Case Data dialog box for the first case you selected is displayed.
6. By default, all document types and data are selected. To exclude a document type from being replicated offline, clear its check box.
7. Click **Groups** to add the data you selected to a data group. The Data Groups dialog box is displayed. Select the group to which you want to add the data and click **OK**.
   **Note** You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see “Working with Data Groups” on page 78.
8. Click **Next**. If you selected more than one case, the Replication Wizard–Case Data dialog box for the next case you selected is displayed.
9. Repeat steps 6–8 for each case you want to replicate offline.
10. When you have finished selecting the document types for all the cases you want to replicate offline, click **Finish**. The Cases Replicated to Offline dialog box is displayed, informing you that the cases were successfully replicated offline.
11. Click **Close**. West Case Notebook is closed.
1. If you replicated cases offline, the next time you access West Case Notebook, the Replication Wizard–Offline Cases dialog box is displayed (Figure 2-12).

![Figure 2-12. Replication Wizard–Offline Cases dialog box](image)

2. By default, all the cases that you replicated offline are selected. To exclude a case from being replicated to the network, clear its check box.

3. Click Finish. The Cases Replicated to Network dialog box is displayed.

![Figure 2-13. Cases Replicated to Network dialog box](image)

4. Select a case, then click one of the following:
   - Open Case. The case is displayed in the left pane.
   - Close. The case is closed.

### Changing Replication Options

West Case Notebook has replication options that prompt you to replicate the case offline when you close West Case Notebook or replicate the case to the network when you open West Case Notebook. To change these options, complete these steps:
1. From the Tools menu, choose **Options**. The Options dialog box is displayed (Figure 2-14).

![Figure 2-14. Options dialog box](image)

2. Select the **Replicate offline on closing West LiveNote** check box, if desired.
3. Clear the **Replicate to the network on opening West LiveNote** check box, if desired.
4. Make your selection the default, if desired.
5. Click **OK**.

**Creating a Case Report**

This report includes the names of documents and any comments about the documents. To create a Case report, complete these steps:

1. Click the **Report** button ( ) on the Main Menu toolbar, then choose **Case** from the menu. The Case Report Properties dialog box is displayed (Figure 2-15). By default, all document types and data are selected. To exclude a document type from the report, clear its check box. To exclude particular data from the report, click the document type containing the data, then clear the check boxes for the data you want to exclude.

![Figure 2-15. Case Report Properties dialog box](image)
2. Click **Groups** to include only the data in a data group in your report. Select the group you want to include in your report and click **OK**. For further information on data groups, see “Working with Data Groups” on page 78.

3. Click the **Display** tab to view a list of display options. Type a title for the report in the **Title** text box, if desired. Then select or clear the appropriate check boxes.

4. Clear the **Include cover page when printing or saving** check box, if desired.

5. Click **OK**. The Case report is listed under **Report** in the left pane and the text of the report is displayed on the **Report** tab in the right pane.
3 Managing Transcripts

**Importing a Transcript**

To import a transcript, complete these steps:

1. Click the New arrow on the Main Menu toolbar and choose Transcript (from File) from the menu. The Import Wizard–Transcript File dialog box is displayed.

2. Click Browse to display the Browse for Transcript Files dialog box.

3. Choose a file type from the Files of type drop-down list. Then select your transcript and click Open. The Import Wizard–Transcript File dialog box is redisplayed.

4. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click Continue. The Import Wizard–Transcript Properties dialog box is displayed (Figure 3-1).

![Figure 3-1. Import Wizard–Transcript Properties dialog box](image)

5. Type a comment in the Comment text box, if desired.

6. Click Groups to add the transcript to a data group. The Data Groups dialog box is displayed. Select the group to which you want to add the data and click OK. The Import Wizard–Transcript Properties dialog box is redisplayed.

   **Note** You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see “Working with Data Groups” on page 78.
7. Click **Finish**. The Import Wizard–Import Summary dialog box is displayed. To import another transcript, click **Again**. If you do not want to import another transcript, click **Close**. The transcript is listed under **Transcripts** in the left pane and the text of the transcript is displayed in the right pane (Figure 3-2).

![Figure 3-2. Imported transcript](image)

**Note** If you see 📞 next to the transcript, the transcript has been signed.

West Case Notebook automatically adds characters in the transcript to the list of characters in the case. If characters are added when you import the transcript, the Characters tab is also displayed after you import the transcript.

**Opening an Existing Transcript**

To open a transcript, complete these steps:

1. If necessary, click **Transcripts** in the left pane to display a list of all transcripts in the case.
2. Double-click the transcript you want to open. The text of the transcript is displayed in the right pane.

**Creating a Transcript Summary**

The Transcript Summary feature allows you to summarize portions of a transcript and create a report of the transcript summary items. To create a transcript summary, complete these steps:

1. Open the transcript you want to summarize.
2. Click the **New** arrow on the Main Menu toolbar and choose **Transcript Summary** from the menu. The **Summary Item** section is displayed below the transcript in the right pane, shown outlined in Figure 3-3.

![Figure 3-3. Summary Item section](image)

3. The arrows in the left margin of the transcript designate the start and end positions of the transcript summary item. By default, page 1, line 1 is the start position and page 1, line 2 is the end position of the first summary item.

   To change the start position,
   - type a new page and line number, e.g., **13:25**, in the **Start Position** text box on the toolbar in the **Summary Item** section
   - click the arrow next to the **Start Position** text box and choose a page and line number from the drop-down list

   To change the end position,
   - type a new page and line number, e.g., **15:9**, in the **End Position** text box
   - click the arrow next to the **End Position** text box and choose a page and line number from the drop-down list
   - click a page and line number in the left margin of the transcript

   **Note** You can set start and end positions only for portions of the transcript that you have not summarized previously.

4. Type a name for the transcript summary item, e.g., **Current employment**, in the **Subject** text box, if desired.

5. Under **Subject**, type a summary of the portion of the transcript you selected, if desired.

   **Note** You can also copy transcript text and paste it in the summary item, if desired.

6. To check the spelling in a summary item, click the **Spellcheck** button ( ) on the toolbar.

7. To create a new transcript summary item, click the **New Summary Item** button ( ) on the toolbar.

8. To view consecutive summary items, click the **Previous Item** button ( ) or the **Next Item** button ( ) on the toolbar.

9. To close the **Summary Item** section, click the **Close** button ( ).

   All summary items are saved automatically when you click the **New Summary Item** button or close the **Summary Item** section. They are listed in the Summary Items folder under the transcript in the left pane.
CREATING A TRANSCRIPT SUMMARY REPORT

This report lists the page and line numbers, the subject, and the text of all transcript summary items. To create a Transcript Summary report, complete these steps:

1. Click the Transcript Summary Report button (Transcript Summary Report) on the toolbar in the Summary Item section or click the Report button (Report •) on the Main Menu toolbar and choose Transcript Summaries from the menu. The Transcript Summary Report Properties dialog box is displayed.

2. All of the transcripts in the case are selected on the Data tab by default. To remove a transcript from the report, clear its check box.

3. Click Groups to include the data in a data group in your outline. The Data Groups dialog box is displayed. Select the group you want to include in the outline and click OK. The Transcript Summary Report Properties dialog box is redisplayed.

4. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. Then select or clear the appropriate check boxes.

5. Click OK. The Transcript Summary report is listed under Report in the left pane and the text of the report is displayed on the Report tab in the right pane.

SAVING A TRANSCRIPT SUMMARY REPORT

To save a transcript summary report, complete these steps:

1. Click Save As on the toolbar above the report in the right pane. The Save As dialog box is displayed.

2. Select a location for the file.

3. Type a name for the file in the File name text box.

4. Choose a file type from the Save as type drop-down list.

5. Click Save.

PRINTING A TRANSCRIPT SUMMARY REPORT

To print a transcript summary report, click Print on the toolbar above the report in the right pane to display the Print dialog box. Then click Print.

OPENING A TRANSCRIPT SUMMARY ITEM

1. If necessary, click Transcripts in the left pane to display a list of all transcripts in the case.

2. Double-click the transcript containing the summary item you want to open. The text of the transcript is displayed in the right pane.

3. Double-click the Summary Items folder under the transcript in the left pane to view a list of summary items.

4. Double-click the summary item you want to open. The item is displayed in the Summary Item section below the transcript in the right pane.

DELETING A TRANSCRIPT SUMMARY ITEM

To delete a summary item, right-click the summary item in the left pane and click Delete. The message Permanently delete the selected summary item? is displayed. Click Yes.

CLOSING A TRANSCRIPT

To close a transcript so that it is no longer displayed in the right pane, click the Close button (X) on the transcript's tab.
Deleting a Transcript
To delete a transcript, right-click the transcript in the left pane and choose Delete from the menu. The message Permanently delete the selected Transcript and all associated Annotations? is displayed. Click Yes.

Printing a Transcript with Annotations
You can display annotations, Quick Marks, and Issue Marks in printed transcripts. For condensed transcripts, you can also print annotations, including notes and author information, in the footer of the document. To print a transcript with annotations in the footer of the document, complete these steps:

1. Open the transcript you want to print.
2. Click the Print arrow on the toolbar above the transcript and choose Print Preview Condensed from the menu. The Print Preview dialog box is displayed.
3. Click the Properties icon to display the Page Setup–Condensed Transcript dialog box (Figure 3-4).
4. Click the Annotations tab (Figure 3-4).

   ![Page Setup–Condensed Transcript dialog box–Annotations tab](image)

5. Select the Display Annotations check box, if necessary.
6. To include or exclude annotations associated with specific issues from the printed transcript, click Select Issues. The Select Issues dialog box is displayed. Issues will be listed in this dialog box only if they have previously been created. See "Working with Issues" on page 64.
7. Select or clear the check boxes next to the issues you want to include or exclude and click OK. The Page Setup–Condensed Transcript dialog box is redisplayed.
8. Clear the Include Quick Marks check box, if desired.
9. Clear the Include Annotations with no Issues check box, if desired.
10. Choose how you want the annotations displayed in the transcript text from the Display drop-down list.
11. Click **OK**. The transcript with its annotations is displayed (Figure 3-5).

![Figure 3-5. Preview of transcript with annotations](image)

12. Click the **Print** icon to print the transcript.
4 Updating Transcripts

West Case Notebook transcripts can be updated using the following types of files:

- E-Transcript (PTX or EXE) files—files containing transcript text and, if the transcript is signed, the signature details
- ASCII (text only) files—files containing transcript text, usually received from the court reporter
- Portable Transcript (PTF) files—files containing transcript text and annotations, usually received from another West Case Notebook user
- LiveNote Evidence Format (LEF) files—files containing transcripts, exhibits, exhibit links, and possibly synchronized video

**Note** You can also import CT Summation (TRN) files and Timaro Technologies Post-Production Time-Stamp (PTS) files.

Any annotations, including Quick Marks and Issue Marks, are automatically transferred to the updated transcript. No work product will be lost because all annotations are linked to the transcript text, not to the page and line references. Therefore, annotations made in the old transcript are simply transferred to the same text location in the updated transcript.

**Starting the Updating Process**
To update a transcript, you must first assign draft status to the transcript. To assign draft status to a transcript, complete these steps:

1. Click the **Transcript Properties** button ( ) on the toolbar above a transcript in the right pane to display the Transcript Properties dialog box.
2. Choose **Draft** from the **Status** drop-down list.
3. Click **OK**.

**Updating with a PTX or EXE File**
1. Click the **Update Transcript** button ( ) on the toolbar above a transcript in the right pane. The Update Transcript–Transcript File dialog box is displayed.
2. Click **Browse** to display the Browse for Transcript Files dialog box.
3. Select the PTX or EXE file that was sent to you and click **Open**. The Update Transcript–Transcript File dialog box is redisplayed.
4. Click **Next**. A message warning that the transcript has not been signed electronically may be displayed. Click **Continue**. The Update Transcript–Transcript Properties dialog box is displayed.
5. Click **Finish**. The Update Transcript–Update Completed dialog box is displayed.
6. Click **Close**.

**Updating with an ASCII File**
1. Click the **Update Transcript** button ( ) on the toolbar above a transcript in the right pane. The Update Transcript–Transcript File dialog box is displayed.
2. Click **Browse** to display the Browse for Transcript Files dialog box.
3. Select the ASCII file that was sent to you and click **Open**. (Different CAT systems create different extensions on ASCII files.) The Update Transcript–Transcript File dialog box is redisplayed.
4. Click **Next**. A message warning that the transcript has not been signed electronically may be displayed. Click **Continue**. The Update Transcript–Import Details dialog box is displayed.

5. Click **Next**. The Update Transcript–Import Confirm dialog box is displayed.

6. Click **Next**. The Update Transcript–Transcript Properties dialog box is displayed.

7. Click **Finish**. The Update Transcript–Update Completed dialog box is displayed.

8. Click **Close**.

**Updating with a PTF File**

Use this method when you want to merge two sets of annotations into one transcript when replication is not available.

1. Click the **Update Transcript** button ( ) on the toolbar above a transcript in the right pane. The Update Transcript–Transcript File dialog box is displayed.

2. Click **Browse** to display the Browse for Transcript Files dialog box.

3. Select the PTF file and click **Open**. The Update Transcript–Transcript File dialog box is displayed.

4. The **Replace existing text with new text** check box is automatically selected. If there are no changes to the text and you want to only merge annotations, clear the check box.

5. The **Import Annotations** check box is automatically selected. If you want to only replace text and not merge annotations, clear the check box.

6. Under **Import Annotations**, **Add to existing annotations** is automatically selected. This is the correct selection for merging annotations. Select **Replace existing Annotations** if you want to replace one set of annotations with another set.

7. Click **Next**. A message warning that the transcript has not been signed electronically may be displayed. Click **Continue**. The Update Transcript–Transcript Properties dialog box is displayed.

8. Click **Finish**. The Update Transcript–Update Completed dialog box is displayed.

9. Click **Close**.

**Updating with a LEF File**

LEF files may contain the transcript with exhibit files and links to exhibit references in the transcript, the transcript with exhibit files and links to exhibit references in the transcript and synchronized video, or the transcript with synchronized video but no exhibits or exhibit links.

1. Click the **Update Transcript** button ( ) on the toolbar above a transcript in the right pane. The Update Transcript–Transcript File dialog box is displayed.

2. Click **Browse** to display the Browse for Transcript Files dialog box.

3. Select the LEF file and click **Open**. The Update Transcript–Transcript File dialog box is redisplayed.

4. The **Replace existing text with new text** check box is automatically selected. If there are no changes to the transcript text, clear the check box.

5. The **Import exhibits** check box is automatically selected. If you do not want to import exhibits, clear the check box.

6. The **Import Annotations** check box is automatically selected. If you do not want to import annotations, clear the check box.

7. Under **Import Annotations**, **Add to existing Annotations** is automatically selected. This is the correct selection for merging the annotations. Select **Replace existing Annotations** if you want to replace one set of annotations with another set.
8. Click **Next**. A message warning that the transcript has not been signed electronically may be displayed. Click **Continue**. The Update Transcript–Transcript Properties dialog box is displayed.

9. Click **Finish**. The Update Transcript–Update Completed dialog box is displayed.

10. Click **Close**.
You can add key documents to West Case Notebook to quickly categorize and search.

Importing a Document
To import a document, complete these steps:

1. Click the New arrow on the Main Menu toolbar and choose Document (from File) from the menu. The Data Import Wizard–Document Files dialog box is displayed.
2. Click Add to display the Open dialog box.
3. Select your document and click Open. The Data Import Wizard–Document Files dialog box is redisplayed.
4. Click Groups to add the document to a data group. The Data Groups dialog box is displayed. Select the group to which you want to add the data and click OK. The Data Import Wizard–Document Properties dialog box is redisplayed.
   
   Note You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see “Working with Data Groups” on page 78.
5. Click Next. The Data Import Wizard–Document Properties dialog box is displayed (Figure 5-1).

Figure 5-1. Data Import Wizard–Document Properties dialog box

6. Type a name for the document, e.g., JobSummary_1005, in the Title text box.
7. Choose a document type from the Type drop-down list, if desired.
8. Type the author’s name in the Author text box or choose the name from the drop-down list, if desired.
9. Type the recipient’s name in the Recipient text box or choose the name from the drop-down list, if desired.
10. Type a number in the Bates range and Through text boxes, if desired.
11. Select the Document Date check box, if desired. When you select this check box, the current day’s date is entered in the text box automatically. Click the arrow to select another date.
12. The OCR check box is automatically selected if the document is an image file or PDF file.
13. Click Finish. The Import Completed dialog box with a list of the documents that you imported is displayed.
If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking Copy to Clipboard and pasting the message into another application.

14. Click OK. The document is listed under Documents in the left pane and the text of the document is displayed in the right pane (Figure 5-2).

![Imported document](image)

**Figure 5-2. Imported document**

**Importing Multiple Documents**

To import multiple documents, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar and choose **Document (from File)** from the menu. The Data Import Wizard–Document Files dialog box is displayed.

2. Click **Add** to display the Open dialog box (Figure 5-3).

![Open dialog box](image)

**Figure 5-3. Open dialog box**
3. Select your documents and click **Open**. The Data Import Wizard–Document Files dialog box is redisplayed (Figure 5-4).

![Figure 5-4. Data Import Wizard–Document Files dialog box](image)

**Note** For most file types, each file is imported as a separate document. For image files, you have the option of importing each file as a separate document or merging multiple files into one document. To merge multiple image files, make sure the **Batch Import, each file is separate document** check box is clear. To import each file as a separate document, select the check box.

4. Click **Groups** to add the documents to a data group. The Data Groups dialog box is displayed. Select the group to which you want to add the data and click **OK**. The Data Import Wizard–Document Properties dialog box is redisplayed.

**Note** You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see "Working with Data Groups" on page 78.

5. Click **Finish**. The Import Completed dialog box with a list of the documents that you imported is displayed.

**Note** If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking **Copy to Clipboard** and pasting the message into another application.

6. Click **OK**. The documents are listed under **Documents** in the left pane and the text of the first document is displayed in the right pane.

**Importing Load Files**

To import a load file, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar and choose **Document (from File)** from the menu. The Data Import Wizard–Document Files dialog box is displayed.

2. Click **Load File** to display the Open dialog box.

3. Select your document and click **Open**. The Data Import Wizard–Document Files dialog box is redisplayed.

4. Click **Groups** to add the documents to a data group. The Data Groups dialog box is displayed. Select the group to which you want to add the data and click **OK**. The Data Import Wizard–Document Properties dialog box is redisplayed.
Note  You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see “Working with Data Groups” on page 78.

5. **Click Next.** The Data Import Wizard–Load Files: Select the Load File Field Delimiter dialog box is displayed (Figure 5-5).

![Figure 5-5. Data Import Wizard–Load Files: Select the Load File Field Delimiter dialog box](image)

6. Choose the file type for the load file from the **File Type** drop-down list. The field delimiter, row delimiter, and text qualifier are automatically entered for you. The **First row contains field names** check box is selected, if appropriate.

   **Note**  If your load file is not listed in the **File Type** drop-down list, choose **Custom** from the list. Then choose the appropriate field delimiter, row delimiter, and text qualifier from the drop-down lists.

7. **Click Next.** The Data Import Wizard–Load Files: Select the Load File Field Mappings dialog box is displayed (Figure 5-6).

![Figure 5-6. Data Import Wizard–Load Files: Select the Load File Field Mappings dialog box](image)
8. Assign a title to each field in the file by mapping the field. For example, to map the first field, which contains Bates Numbers, in Figure 5-6, select the field by clicking [none] at the top of the first column. Then choose Bates Number from the Mapping drop-down list. Repeat this process for each field you want to map.

Note You must map the File Path and Name field to import the file. If the file path and file name are not in the same field, map the File Path and File Name fields separately.

9. If you do not want to import a field, select the field and then select the Do not import field (Skip) check box.

10. If a field indicates that the load file contains a row for each page of a document, select the field. Then select the Field indicates start of new document when check box and choose an option from the drop-down list.

11. Click Finish. The Import Completed dialog box with a list of the documents that you imported is displayed.

Note If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking Copy to Clipboard and pasting the message into another application.

12. Click OK. The documents are listed under Documents in the left pane.

**Sending Documents to West Case Notebook Using Windows Explorer**

You can send documents that are saved on your computer to West Case Notebook using Windows Explorer. To send a document using Windows Explorer, complete these steps:

1. Locate the document you want to send. For example, if you saved the document in the My Documents folder on your desktop, double-click the My Documents icon to open the folder.

2. Right-click the document, then choose Send To, Case Notebook as Document from the menu (Figure 5-7). The Data Import Wizard–Document Properties dialog box is displayed.

3. Fill in the text boxes as appropriate.

4. Click Finish. The Import Completed dialog box with a list of the documents that you imported is displayed.

Note If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking Copy to Clipboard and pasting the message into another application.

5. Click OK. The document is listed under Documents in the left pane and the text of the document is displayed in the right pane.
Sending Documents to West Case Notebook from Microsoft Outlook

You can send e-mail and attached documents to West Case Notebook directly from Microsoft Outlook. When you install West Case Notebook, a Case Notebook menu is automatically displayed in Microsoft Outlook (Figure 5-8).

Figure 5-8. Case Notebook menu in Microsoft Outlook

To send an e-mail and an attached document from Microsoft Outlook, complete these steps:

1. Access Microsoft Outlook.
2. Select the e-mail you want to send.
3. From the Case Notebook menu, choose **Send as Document**. The Data Import Wizard–Load Files dialog box is displayed (Figure 5-9).

Figure 5-9. Data Import Wizard–Load Files dialog box

4. Click **Finish**. The Import Completed dialog box with a list of the documents that you imported is displayed.

   **Note** If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking **Copy to Clipboard** and pasting the message into another application.

5. Click **OK**. The e-mail and attachment are listed under *Documents* in the left pane and the text of the e-mail is displayed in the right pane (Figure 5-10).

![Figure 5-10. E-mail and attached document](image)

**Opening an Existing Document**

To open a document, complete these steps:

1. If necessary, click **Documents** in the left pane to display a list of all documents in the case.
2. Double-click the document you want to open. The text of the document is displayed in the right pane.

**Deleting a Document**

To delete a document, right-click the document in the left pane and choose **Delete** from the menu. The message *Permanently delete the selected Document and all associated Annotations?* is displayed. Click **Yes**.

**Closing a Document**

To close a document so that it is no longer displayed in the right pane, click the **Close** button (\[\]\) on the document’s tab.
6 Managing Pleadings

West Case Notebook allows you to add pleadings to categorize and search.

Importing a Pleading

To import a pleading, complete these steps:

1. Click the New arrow on the Main Menu toolbar and choose Pleading (from File) from the menu. The Data Import Wizard–Pleading Files dialog box is displayed.
2. Click Add to display the Open dialog box.
3. Select your pleading and click Open. The Data Import Wizard–Pleading Files dialog box is redisplayed.
4. To add the pleading to a data group, click Groups. The Data Groups dialog box is displayed. Select the group to which you want to add the pleading and click OK. The Data Import Wizard–Pleading Properties dialog box is redisplayed.

Note: You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see “Working with Data Groups” on page 78.

5. Click Next. The Data Import Wizard–Pleading Properties dialog box is displayed (Figure 6-1).

![Figure 6-1. Data Import Wizard–Pleading Properties dialog box]

6. Type a name for the pleading, e.g., Answer_BowerDC, in the Title text box.
7. Choose a type from the Type drop-down list, if desired.
8. Type the author’s name in the Author text box or choose the name from the drop-down list, if desired.
9. Type the recipient’s name in the Recipient text box or choose the name from the drop-down list, if desired.
10. Select the Document Date check box, if desired. When you select this check box, the current day’s date is entered in the text box automatically. Click the arrow to select another date.
11. The OCR check box is automatically selected if the pleading is an image file or PDF file.
12. Click Finish. The Import Completed dialog box with a list of the pleadings that you imported is displayed.
Note If West Case Notebook fails to import a pleading, an error message is displayed in the dialog box. You can record the error by clicking Copy to Clipboard and pasting the message into another application.

13. Click OK. The pleading is listed under Pleadings in the left pane and the text of the pleading is displayed in the right pane (Figure 6-2).

Sending Pleadings to West Case Notebook Using Windows Explorer

You can send pleadings that are saved on your computer to West Case Notebook using Windows Explorer. To send a pleading using Windows Explorer, complete these steps:

1. Locate the pleading you want to send. For example, if you saved the pleading in the My Documents folder on your desktop, double-click the My Documents icon to open the folder.

2. Right-click the pleading, then choose Send To, Case Notebook as Pleading from the menu (Figure 6-3). The Data Import Wizard–Pleading Properties dialog box is displayed.

3. Fill in the text boxes as appropriate.

4. Click Finish. The Import Completed dialog box with a list of the pleadings that you imported is displayed.

Note If West Case Notebook fails to import a pleading, an error message is displayed in the dialog box. You can record the error by clicking Copy to Clipboard and pasting the message into another application.
5. Click OK. The pleading is listed under Pleadings in the left pane and the text of the pleading is displayed in the right pane.

**Sending Pleadings to West Case Notebook from Microsoft Outlook**

You can send e-mail and attached pleadings to West Case Notebook directly from Microsoft Outlook. When you install West Case Notebook, a Case Notebook menu is automatically displayed in Microsoft Outlook (Figure ).

![Case Notebook menu in Microsoft Outlook](image)

To send an e-mail and an attached pleading from Microsoft Outlook, complete these steps:

1. Access Microsoft Outlook.
2. Select the e-mail you want to send.
3. From the Case Notebook menu, choose **Send as Pleading**. The Data Import Wizard–Load Files dialog box is displayed (Figure 6–4).

![Figure 6-4. Data Import Wizard–Load Files dialog box](image)

4. Click **Finish**. The Import Completed dialog box with a list of the pleadings that you imported is displayed.

   **Note** If West Case Notebook fails to import a pleading, an error message is displayed in the dialog box. You can record the error by clicking **Copy to Clipboard** and pasting the message into another application.
5. Click OK. The e-mail and attachment are listed under Pleadings in the left pane and the text of the e-mail is displayed in the right pane (Figure 6-5).

![Figure 6-5. E-mail and attached pleading](image)

**Opening an Existing Pleading**
To open a pleading, complete these steps:

1. If necessary, click Pleadings in the left pane to display a list of all pleadings in the case.
2. Double-click the pleading you want to open. The text of the pleading is displayed in the right pane.

**Deleting a Pleading**
To delete a pleading, right-click the pleading in the left pane and choose Delete from the displayed menu. The message *Permanently delete the selected Pleading and all associated Annotations?* is displayed. Click Yes.

**Closing a Pleading**
To close a pleading so that it is no longer displayed in the right pane, click the Close button (_calendar) on the pleading’s tab.
If you are conducting research on Westlaw, you can send your Westlaw search result to West Case Notebook. From West Case Notebook, you can quickly update KeyCite information and access Westlaw to conduct further research.

Searching Westlaw
For more information on using Westlaw, download a free copy of the *Westlaw User Guide* at west.thomson.com/westlaw/guides.

To search Westlaw, complete these steps:

1. From the Search menu in West Case Notebook, choose **Westlaw Search**. The Search Westlaw: Westlaw Search Options dialog box is displayed (Figure 7-1).

   ![Figure 7-1. Search Westlaw: Westlaw Search Options dialog box](image)

2. By default, **Search Westlaw** is selected. To search Westlaw Canada, select **Search Westlaw Canada**. Click **Save**. The Search Westlaw dialog box is displayed (Figure 7-2).

   **Note** When you click **Save**, your preference is stored as a cookie in your browser. To view the options again, you must first delete cookies from your browser, then repeat step 1.
3. By default, the Terms and Connectors tab is displayed. Type your Terms and Connectors query, e.g., `retaliat! wrongful! /5 terminat! discharg! /s work! /5 compensat! & da(aft 2006)`, in the Terms text box.

4. Under Source, type a database identifier in the text box or choose a database, e.g., All Federal Cases (ALLFEDS), from the drop-down list.

5. Click Search Westlaw. The Westlaw sign-on page is displayed.

6. Type your OnePass username, password, and client identifier in the text boxes.

7. Click Sign On. The result list for your search is displayed (Figure 7-3).
USING WESTFIND&PRINT

You can use the WestFind&Print feature on Westlaw to retrieve documents by citation and send them directly to West Case Notebook. To send documents to West Case Notebook, complete these steps:

1. Click **Find&Print** at the top of any Westlaw page to display the Find a Document page (Figure 7-4).

   ![Figure 7-4. Find a Document page](image)

2. Type one or more citations in the **Enter Citation(s)** text box in the right frame. You can type up to 20 citations; separate them with a semicolon or hard return.

3. Under **Select Delivery Options**, select **Export to Case Notebook**.

4. Click **Send Request**. The Export to Case Notebook dialog box is displayed.

5. Complete steps 2–10 above to view the documents in West Case Notebook.

SENDING A WESTLAW SEARCH RESULT TO WEST CASE NOTEBOOK

After conducting your research on Westlaw, you can send the result list or selected documents to West Case Notebook. To send the result list or selected documents to West Case Notebook, complete these steps:

1. To send the result list, click the **Export to Case Notebook** icon ( ) in the upper-right corner. To send specific documents in the result list, select the check box next to each document you want to send and then click the **Export to Case Notebook** icon. The Export to Case Notebook page is displayed (Figure 7-5).

   ![Figure 7-5. Export to Case Notebook page](image)
2. Make certain the matter number corresponds to the client-matter number for the case in West Case Notebook. (To view the client-matter number for the case, choose Case Properties from the File menu in West Case Notebook.)

3. Choose an issue from the Recent Categories drop-down list, if desired.

4. Type a comment in the Comments text box, if desired.

5. Click Save. The Download Confirmation dialog box is displayed.

6. Click Complete Download. The File Download dialog box is displayed.

7. Click Open. The Data import Wizard–Research Files dialog box is displayed.

8. To add the document to a data group, click Groups. The Data Groups dialog box is displayed. Select the group to which you want to add the document and click OK. The Data Import Wizard–Research Files dialog box is redisplayed.

   Note You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see “Working with Data Groups” on page 78.

9. Click Finish. The Import Completed dialog box with a list of the documents that you imported is displayed.

   Note If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking Copy to Clipboard and pasting the message into another application.

10. Click OK. The Westlaw result list or documents you selected are listed under Research in the left pane and the result list or the text of the first document is displayed in the right pane (Figure 7-6).

   Figure 7-6. Imported Westlaw document
Searching WestlawNext

For further information on WestlawNext, download a free copy of *Welcome to WestlawNext: Introducing the Basics* at west.thomson.com/westlaw/guides.

To search WestlawNext, complete these steps:

1. From the Search menu in West Case Notebook, choose **Westlaw Search**. The Search Westlaw: Westlaw Search Options dialog box is displayed (Figure 7-7).

   ![Figure 7-7. Search Westlaw: Westlaw Search Options dialog box](image)

2. By default, **Search Westlaw** is selected. Click **Save**. The Search Westlaw dialog box is displayed (Figure 7-8).

   **Notes**

   - When you click **Save**, your preference is stored as a cookie in your browser. To view the options again, you must first delete cookies from your browser, then repeat step 1.
   - You can search Westlaw from West Case Notebook, even if you selected WestlawNext as your default search method. To search Westlaw, open an outline, then click the **Insert** button and choose **Insert Westlaw Outline** from the menu. At the Search Westlaw dialog box, click the **Terms and Connectors** tab.
3. Type terms describing your issue in the text box.
4. Select up to three jurisdictions under **Jurisdiction**.
5. Click the search icon ( ). The WestlawNext sign-on page is displayed.
6. Type your OnePass username and password in the text boxes.
7. Click **Sign On**. The client ID page is displayed
8. At the next page, click **Continue**. unless you want to change your client ID. The result list for your search is displayed (Figure 7-9).
SENDING A WESTLAWNEXT RESEARCH DOCUMENT TO WEST CASE NOTEBOOK

After conducting your research on WestlawNext, you can send the full text of a document to West Case Notebook. To send a document to West Case Notebook, complete these steps:

1. Click the arrow next to the delivery icon and choose Export to Case Notebook from the menu. The Export to Case Notebook dialog box is displayed (Figure 7-10).

   ![Figure 7-10. Export to Case Notebook dialog box](image)

2. Make certain the matter number corresponds to the client-matter number for the case in West Case Notebook. (To view the client-matter number for the case, choose Case Properties from the File menu in West Case Notebook.)

3. The title of the document is entered for you in the Title text box. Type a different title, if desired.

4. Type a category in the Category text box, if desired.

5. Type a comment in the Comments text box, if desired.

6. Click the Layout and Limits tab to specify elements you want to include with the document.

7. Click Export. The Ready For Download dialog box is displayed.

8. Click Download. The File Download dialog box is displayed.

9. Click Open. The Data import Wizard–Research Files dialog box is displayed.

10. Click Finish. The Import Completed dialog box with a list of the documents that you imported is displayed.

   **Note** If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking Copy to Clipboard and pasting the message into another application.

11. Click OK. The WestlawNext document you sent is listed under Research in the left pane and the text of the document is displayed in the right pane.
Updating KeyCite Information

You can quickly update KeyCite information for a Westlaw document in West Case Notebook. To update KeyCite information, complete these steps:

1. Choose **Update KeyCite Flags** from the Tools menu in West Case Notebook. The Update KeyCite Login dialog box is displayed (Figure 7-11).

![Figure 7-11. Update KeyCite Login dialog](image)

2. Type your OnePass username and password in the text boxes and click **OK**.

3. The Update KeyCite Report is listed under **Report** in the left pane and the text of the report is displayed in the right pane (Figure 7-12).

![Figure 7-12. Update KeyCite Report](image)

**Note**  Research items with a changed status will be highlighted in yellow.

Sending Research Documents to West Case Notebook Using Windows Explorer

You can send research documents that are saved on your computer to West Case Notebook using Windows Explorer. To send a research document using Windows Explorer, complete these steps:

1. Locate the research document you want to send. For example, if you saved the research document in the My Documents folder on your desktop, double-click the **My Documents** icon to open the folder.
2. Right-click the research document, then choose **Send To, Case Notebook as Research** from the menu (Figure 6-3). The Data Import Wizard–Research Properties dialog box is displayed.

![Figure 7-13. Windows Explorer menu](image)

3. Fill in the text boxes as appropriate.

4. Click **Finish**. The Import Completed dialog box with a list of the documents that you imported is displayed.

   **Note** If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking **Copy to Clipboard** and pasting the message into another application.

5. Click **OK**. The research document is listed under **Research** in the left pane and the text of the research document is displayed in the right pane.

**Importing Research Documents**

You can import other research documents into West Case Notebook.

To import a research document, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar and choose **Research (from File)** from the menu. The Data Import Wizard–Research Files dialog box is displayed.

2. Click **Add** to display the Open dialog box.

3. Select your research document and click **Open**. The Data Import Wizard–Research Files dialog box is redisplayed.

4. To add the document to a data group, click **Groups**. The Data Groups dialog box is displayed. Select the group to which you want to add the document and click **OK**. The Data Import Wizard–Research Files dialog box is redisplayed.

   **Note** You can use data groups to organize data in categories, which are displayed as folders under data categories in the left pane. For more information on data groups, see “Working with Data Groups” on page 78.
5. Click **Next**. The Data Import Wizard–Research Properties dialog box is displayed (Figure 7-14).

![Data Import Wizard–Research Properties dialog box](image)

**Figure 7-14. Data Import Wizard–Research Properties dialog box**

6. Type a name for the research document, e.g., **39 Cal.4th 260**, in the **Title** text box.

7. Choose a document type from the **Type** drop-down list, if desired.

8. Choose an author from the **Author** drop-down list, if desired.

9. Choose a category from the **Category** drop-down list, if desired.

10. Select the **Research Date** check box, if desired. When you select this check box, the current day's date is entered in the text box automatically. Click the arrow to select another date.

11. The **OCR** check box is automatically selected if the document is an image file or PDF file.

12. Click **Finish**. The Import Completed dialog box with a list of the documents that you imported is displayed.

   **Note** If West Case Notebook fails to import a document, an error message is displayed in the dialog box. You can record the error by clicking **Copy to Clipboard** and pasting the message into another application.

13. Click **OK**. The research document is listed under **Research** in the left pane and the text of the document is displayed in the right pane.
Creating a Key Fact

To create a key fact, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar and choose **Key Fact** from the menu. The Key Fact Properties dialog box is displayed (Figure 8-1).

2. Type a name for the key fact, e.g., **Investigation Report**, in the **Title** text box.

3. Select the **Start Date** check box, if desired. If you have not previously created any key facts, the current day’s date is entered in the text box automatically. Otherwise, the start date of the last key fact you created is entered. Type a new start date or click the arrow to select another start date.

4. Select the **Set Time** check box, if desired. If you have not previously created any key facts, **12:00PM** is entered in the text box automatically. Otherwise, the start time of the last key fact you created is entered. Type a different start time, if desired.

5. Select the **End Date** check box, if desired. If you have not previously created any key facts, the current day’s date is entered in the text box automatically. Otherwise, the end date of the last key fact you created is entered. Type a new end date or click the arrow to select another end date.

6. Select the **Set Time** check box, if desired. If you have not previously created any key facts, **12:00PM** is entered in the text box automatically. Otherwise, the end time of the last key fact you created is entered. Type a different end time, if desired.

7. Type a description, e.g., **Request for investigation made by supervisor**, in the **Description** text box.

8. Select the **Undisputed** check box, if desired.

9. Click the **Issues** tab and select one or more issues, if desired. Issues will be listed on this tab only if they have previously been created. See “Working with Issues” on page 64.

10. Click the **Sources** tab and select one or more sources, if desired. Sources will be listed on this tab only if annotations have previously been created. See “Working with Annotations” on page 68.

11. Click the **Characters** tab and select one or more characters, if desired. Characters will be listed on this tab only if they have previously been created. See “Managing Characters” on page 47.
12. Click **OK**. The key fact is listed under **Key Facts** in the left pane and displayed on the Key Facts tab in the right pane (Figure 8-2).

![Figure 8-2. Key Facts tab](image)

**Creating a Key Facts Report**

To create a Key Facts report, complete these steps:

1. Click the **Report** button ( ) on the Main Menu toolbar, then choose **Key Facts** from the menu. The Key Facts Report Properties dialog box is displayed (Figure 8-3).

![Figure 8-3. Key Facts Report Properties dialog box](image)

2. All of the key facts in the case are selected on the Data tab by default. To remove a key fact from the report, clear its check box.

3. Clear the **Include disputed facts** check box if you want to exclude disputed facts from the report and create an undisputed facts report.

4. Clear the **Include undisputed facts** check box if you want to exclude undisputed facts from the report and create a disputed facts report.
5. Clear the **Group by undisputed facts** check box if you do not want to group undisputed facts in the report to create a report with undisputed and disputed facts grouped together.

6. By default, the key facts in the report will be sorted by date. Choose **Title** from the **Sort by** drop-down list, if desired.

7. Click the **Display** tab to view a list of display options. Type a title for the report in the **Title** text box, if desired. Then select or clear the appropriate check boxes.

8. Click **OK**. The Key Facts report is listed under **Report** in the left pane and the text of the report is displayed on the Report tab in the right pane.

**Editing a Key Fact**
To edit a key fact, right-click the key fact and choose **Properties** from the menu. The Key Fact Properties dialog box is displayed. Make the appropriate changes and click **OK**.

**Deleting a Key Fact**
To delete a key fact, right-click the key fact and choose **Delete** from the menu. The message **Permanently delete the selected Key Fact?** is displayed. Click **Yes**.

**Closing the Key Facts Tab**
To close the Key Facts tab so that it is no longer displayed in the right pane, click the **Close** button (×) on the tab.

**Sending Key Facts to Microsoft Word or Corel WordPerfect**
You can send key facts to Microsoft Word or Corel WordPerfect and then work with them in that word-processing program. To send key facts to a Microsoft Word or Corel WordPerfect, select the check boxes next to the key facts you want to send. Then click **Send** on the toolbar above the key facts in the right pane and choose **Word** or **WordPerfect** from the menu. The program you selected opens and the key facts are displayed in a document.

**Sending Key Facts to West Case Timeline**
You can send key facts to West Case Timeline and use them to create a chart. For more information on West Case Timeline, refer to the **West Case Timeline User Guide**, which can be downloaded at west.thomson.com/support/user-guide/case-timeline.aspx.

To send key facts to West Case Timeline, complete these steps:
1. Select the check boxes next to the key facts you want to send (Figure 8-4).

![Figure 8-4. Selected key facts](image)

2. Click **Send** on the toolbar above the key facts in the right pane, then choose **West Case Timeline** from the menu.

3. The message *Would you like to view import results?* is displayed. Click **Yes** if you want to display a dialog box summarizing the results of the import.

4. If you clicked **Yes** in step 3, the **Import_log.txt–Notepad** dialog box is displayed. Click the **Close** button. The key facts are displayed as events on the Event Entry tab in West Case Timeline.

**Note**

- If West Case Timeline is not open when you send the key facts, West Case Timeline opens automatically and creates a new timeline file for you. If you are working in one or more timelines when you send the key facts, the key facts are displayed in the last timeline you accessed.
- If you modify a key fact in West Case Notebook, you must resend the key fact to West Case Timeline to update the event. Only the modified information in the key fact is sent from West Case Notebook.

**SAVING KEY FACTS AS A WEST CASE TIMELINE FILE**

If desired, you can also save your key facts as a West Case Timeline (TAB) file and then import the file into West Case Timeline.

To create a West Case Timeline file, complete these steps:

1. Choose **Save As**, **Key Facts** from the File menu. The Save As dialog box is displayed.
2. Select a location for the West Case Timeline file.
3. Type a file name in the **File name** text box.
4. Choose **West Case Timeline (*.tab)** from the **Save as type** drop-down list.
5. Click **Save**.
9 Managing Characters

With West Case Notebook, you can easily keep track of all the characters in the litigation, such as parties, attorneys, experts, and witnesses, and their contact information.

Adding Characters
You can add characters to a case manually, set West Case Notebook to add characters automatically, or add characters from a smart tags list.

To add characters manually, you can
• create a character
• import characters from a comma separated value (CSV) file

West Case Notebook can add characters automatically when you
• enter or change the properties in a transcript, document, pleading, or outline
• import transcripts, documents, or pleadings

ADDING CHARACTERS MANUALLY

Creating a Character
To create a character, complete these steps:

1. Click the New arrow on the Main Menu toolbar and choose Character from the menu. The Character Properties dialog box is displayed (Figure 9-1).

2. Fill in the text boxes as appropriate.
3. Click OK. The character is listed under Characters in the left pane and displayed on the Characters tab in the right pane (Figure 9-2).

![Figure 9-2. Characters tab](image)

**Importing Characters from a CSV File**

You can import a CSV file that contains information about characters. If desired, you can create a CSV file by exporting characters from West Case Notebook or contacts from Microsoft Outlook. For further information on exporting characters from West Case Notebook, see “Exporting Characters to a File” on page 53.

**Note** The CSV file must contain the same fields as those for contacts in Microsoft Outlook.

To import characters from a CSV file, complete these steps:

1. Click the New arrow on the Main Menu toolbar and choose **Characters (from File)** from the menu. The Open dialog box is displayed.
2. Select the file containing the characters you want to import and click **Open**. A message indicating that the characters were successfully imported or updated is displayed.
3. Click **OK**. The characters are listed under **Characters** in the left pane and displayed on the Characters tab in the right pane.

**ADDING CHARACTERS AUTOMATICALLY**

**Changing the Properties of Transcripts, Documents, Pleadings, and Outlines**

West Case Notebook automatically adds characters when you add or change the name of a deponent in a transcript or outline or the author or recipient in a document or pleading.

To change the deponent, author, or recipient information, complete these steps:

1. Right-click the transcript, document, pleading, or outline you want to change in the left pane.
2. Choose **Properties** from the displayed menu. The Properties dialog box is displayed.
3. Make the changes in the appropriate text boxes.
4. Click **OK**. The character is listed under **Characters** in the left pane.

If you do not want West Case Notebook to add a character when you change the information in a transcript, document, pleading, or outline, complete these steps:

1. Choose **Options** from the Tools menu. The Options dialog box is displayed.
2. Click the **Characters** tab.
3. Under **Automatically Create Characters from Properties**, clear the appropriate check box.
4. Click OK.

Importing Transcripts, Documents, and Pleadings

When you import a transcript, document, or pleading, West Case Notebook scans the text and identifies the words that appear to be the names of persons or companies. You can set West Case Notebook to automatically add those names as characters to a case. To set West Case Notebook to automatically add characters when you import a transcript, document, or pleading, complete these steps:

1. Choose Options from the Tools menu. The Options dialog box is displayed.
2. Click the Characters tab (Figure 9-3).

   ![Figure 9-3. Options dialog box–Characters tab](image.png)

3. Under Automatically Create Characters from Full Text, select the Create new characters from full text of transcripts, documents, and pleadings check box.
4. Click OK.

Adding Characters from a Smart Tags List

When you import a transcript, document, or pleading, West Case Notebook uses character recognition software to identify words that appear to be the names of persons or companies. It then adds smart tags to those names and generates a list of the smart tags. You can use the list to find references to additional witnesses and specify the characters you want to add to the case.

Smart tags are links to character information in transcripts, documents, and pleadings. Characters with smart tags are underlined with a blue dotted line, shown outlined in Figure 9-4. You can right-click a smart tag to

- modify a character's information
- delete the smart tag
- create a Character report
- retrieve a character's profile on Westlaw

![Figure 9-4. Smart tag](image.png)
Note

• You cannot delete or modify smart tags when you replicate the case offline.

• Smart tags are displayed in the transcript, document, or pleading only when the characters are displayed on the Characters tab.

To add characters to a case from smart tags list, complete these steps:

1. Click the New arrow on the Main Menu toolbar and choose Character (from Smart Tags) from the menu. The Character Smart Tags Wizard dialog box is displayed (Figure 9-5).

2. By default, all of the characters are selected. To exclude a character, clear its check box.

3. Click Finish. The characters are listed under Characters in the left pane and the smart tags are displayed in the transcript, document, or pleading you imported.

To set West Case Notebook to automatically add the characters to the case when you import a transcript, document, or pleading, see “Importing Transcripts, Documents, and Pleadings” on page 49.

Working with Aliases

When you import a transcript, document, or pleading, West Case Notebook scans the text for both the names of individuals and companies and the variations, or aliases, of those names. West Case Notebook then creates a list of the aliases. For example, if West Case Notebook identifies the character Joseph Adams, it may create the alias Joe. You can associate aliases with a character to include all references to the character in a Characters report.

To associate an alias with a character, complete these steps:

1. Click Characters in the left pane to display the Characters tab in the right pane, if necessary.

2. Right-click the character with which you want to associate an alias, e.g., Cole, John, and choose Properties from the displayed menu. The Character Properties dialog box is displayed.
3. Click the Aliases tab (Figure 9-6).

![Figure 9-6. Character Properties dialog box—Aliases tab](image)

4. Under Other Aliases and Characters, select the aliases, e.g., Cole and John, you want to associate with the character.

5. Click the left arrow to move the aliases under Aliases for Displayed Name.

6. Click OK. The message Changes to aliases will not be reflected in Character Smart Tags until you rebuild the Character Smart Tag index. Do you want to rebuild it now? is displayed.

7. Click Yes.

**Retrieving a Character’s Profile from Westlaw**

Character profiles on Westlaw provide background information on individuals and companies including assets; civil filings; criminal records; lawsuit records; corporate records; connections between individuals and companies; and links to cases, jury trials, and settlements in which an attorney, judge, or expert witness has participated.

To retrieve a character’s profile from Westlaw, complete these steps:

1. Click Characters in the left pane to display the Characters tab in the right pane, if necessary.

2. in the right pane, right-click the character for whom you want to retrieve a profile and choose Profile on Westlaw from the displayed menu. Then choose one of the following from the submenu:
   - **PeopleMap (public records)** to search public records using the tabbed PeopleMap page
   - **Expert Library** to search expert materials at the tabbed Expert Center page
   - **Person and Company Library** to search materials for people and companies at the tabbed Person and Company Investigator page
   - **Attorneys and Judges** to search the Profiler—Profiles of Attorneys and Judges database (PROFILER-WLD), which includes the profiles of attorneys and judges from all 50 states, Puerto Rico, the Virgin Islands, the District of Columbia, Canada, England, and Europe)
Arbitrators to search the Profiler–Profiles of Arbitrators database (PROFILER-ARB), which includes the profiles of arbitrators identified in securities, labor, and international arbitration awards and other Westlaw resources.

Note Some sources may not be included in your Westlaw subscription.

3. At the Westlaw sign-on page, type your username, password, and client identifier in the text boxes and click Sign On.

4. Depending on the source you selected in step 2, the appropriate tabbed page or Search page is displayed.

   Note For further information on searching public records on Westlaw, download a free copy of Searching Public Records on Westlaw or Westlaw PeopleMap at west.thomson.com/support/user-guide/westlaw/records.aspx.

5. After you retrieve a character’s profile, click the Export to Case Notebook icon ( ) in the upper-right corner of the profile. The Export to Case Notebook page is displayed.

6. Make certain the matter number corresponds to the client-matter number for the case in West Case Notebook. (To view the client-matter number for the case, choose Case Properties from the File menu in West Case Notebook.)

7. Choose an issue from the Recent Categories drop-down list, if desired.

8. Type a comment in the Comments text box, if desired.

9. Click Save. The Download Confirmation dialog box is displayed.

10. Click Complete Download. The File Download dialog box is displayed.

11. Click Open. The Data import Wizard–Research Files dialog box is displayed.

12. Click Finish. The character’s profile is listed under Research in the left pane and the text of the profile is displayed in the right pane.

Creating a Characters Report

When you import data, West Case Notebook automatically links the names you list under Characters with references to those names in the text of transcripts, documents, or pleadings. This report lists every instance where a character appears in the data. To create a Characters report, complete these steps:

1. Click the Report button ( ) on the Main Menu toolbar, then choose Characters from the menu. The Characters Report Properties dialog box is displayed (Figure 9-7).
2. All of the characters in the case are selected on the Characters tab by default. To remove a character from the report, clear its check box.

3. Click the Data tab to display a list of all document types and data. By default, all document types and data are selected. To exclude a document type from the report, clear its check box. To exclude particular data from the report, click the document type containing the data, then clear the check boxes for the data you want to exclude.

4. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. Then select or clear the appropriate check boxes.

5. Click the Context tab to display a list of context options. Select or clear the appropriate check boxes.

6. Click OK. The Characters report, which includes the lines you marked and the surrounding questions and answers, is listed under Report in the left pane and the text of the report is displayed on the Report tab in the right pane.

Exporting Characters to a File
To generate a list of characters to use apart from West Case Notebook or to import into another West Case Notebook case, you can export the characters to a file. To export characters to a file, complete these steps:

1. Click Characters in the left pane, if necessary, to display the Characters tab in the right pane.

2. Click the Save As arrow on the toolbar above the characters in the right pane and choose Save All from the menu, or, if you selected individual characters on the Characters tab, choose Save Selected from the menu. The Save As dialog box is displayed.

3. Select a location for the file.

4. Type a name for the file in the File name text box.

5. Choose a file type from the Save as type drop-down list.

   Note  If you want to import the characters into a different West Case Notebook case, you must save the list as a CSV file.

6. Click Save.

Editing a Character
To edit the information for a character, right-click the character and choose Properties from the menu. The Character Properties dialog box is displayed. Make the appropriate changes and click OK.

Deleting a Character
To delete a character, right-click the character and choose Delete from the menu. The message Permanently delete the selected Character? is displayed. Click Yes.

Closing the Characters Tab
To close the Characters tab so that it is no longer displayed in the right pane, click the Close button (×) on the tab.
10 Managing Outlines

You can use the Outlines feature in West Case Notebook to gather materials in one place to prepare for events such as trials, depositions, arbitrations, or client interviews. For example, you can type an outline for a deposition and then insert links to potential exhibits, language from key documents, questions from transcripts, and Westlaw research into the outline. All relevant materials are organized and displayed under Outlines in the left pane for easy access and printing.

Creating an Outline
To create an outline, complete these steps:

1. Click the New arrow on the Main Menu toolbar and choose Outline from the menu. The Create New Outline dialog box is displayed (Figure 10-1).

![Create New Outline dialog box](image)

2. Type a last name and first name in the Last and First text boxes.
   **Note** After you create the outline, the deponent is added as a character in the case.

3. Under Deponent, choose a type of witness from the Type drop-down list.

4. The deponent’s name is automatically entered for you in the Title text box. Type a different name for the outline, if desired.

5. Under Outline, choose the type of outline from the Type drop-down list.

6. Type text in the Comments text box, if desired.

7. Click OK.
8. The outline is listed under Outlines in the left pane and displayed on a tab in the right pane (Figure 10-2).

**Inserting Information into an Outline**
To add information to an outline, you can type text in the outline or your can insert

- text from a document
- a report
- potential exhibits
- transcript questions
- a Westlaw document

**Typing Text in the Outline**
You can type text directly in an outline. To format the text, use the icons on the toolbar above the outline or right-click in the outline and choose Format from the displayed menu.

**Inserting Text from a Document**
You can copy text from a document in West Case Notebook and paste it into an outline. For further information, see “Transferring Document Text” on page 80.

**Inserting a Report**

To insert a report into an outline, complete these steps:

1. Create a report.
2. Click Send on the toolbar above the report in the right pane and choose Outline from the menu. The Select Outline dialog box is displayed.
   - **Note** To insert only the questions from the report in the outline, if available, choose Outline (Questions only) from the menu.
3. Select the outline in which you want to insert the report.
3. Click OK. The report is displayed in the outline. To view the outline, click its tab in the right frame, if necessary (Figure 10-3).

**INSERTING POTENTIAL EXHIBITS**

To insert links to potential exhibits in the outline, complete these steps:

1. Click in the outline where you want to insert the exhibits.

2. Click the Insert button (Insert) on the toolbar above the outline and choose Insert Potential Exhibits from the menu. The Insert Potential Exhibits dialog box is displayed (Figure 10-4).

3. Select a document type, then select the check boxes next to the documents you want to include in the outline.

4. Click Groups to include the data in a data group in your outline. The Data Groups dialog box is displayed. Select the group you want to include in the outline and click OK. The Insert Potential Exhibits dialog box is redisplayed.
5. Click OK. A reference to each document is listed under the outline in the left pane and a link to each document is displayed in the outline in the right pane (Figure 10-5).

![Figure 10-5. Outline with exhibits](image)

**INSERTING TRANSCRIPT QUESTIONS**

You can insert transcript questions into an outline using the Insert feature or directly from a transcript using the Send feature.

**Inserting Transcript Questions Using the Insert Feature**

To insert transcript questions into an outline using the Insert feature, complete these steps:

1. Click the **Insert** button ( ) on the toolbar above the outline and choose **Insert Transcript Questions** from the menu. The Insert Transcript Questions dialog box is displayed (Figure 10-6).

![Figure 10-6. Insert Transcript Questions dialog box](image)

2. Select the transcript containing the questions you want to include in the outline.
3. Select the **Include answers** check box, if desired.
4. Click OK. A link to the transcript and the transcript questions are displayed in the outline (Figure 10-7).

**Figure 10-7. Outline with transcript questions**

**Inserting Transcript Questions Using the Send Feature**

To insert transcript questions into an outline using the Send feature, complete these steps:

1. Access the transcript containing the questions you want to send to the outline.
2. Click the arrow next to the Annotate Mode button ( ) on the toolbar above the transcript in the right pane, then choose the Copy button ( ) from the menu.
3. Select the text in the transcript that includes questions you want to send to the outline.
4. Right-click the selected text and choose Send, Outline (Questions only) from the menu. The Select Outline dialog box is displayed.
5. Select the outline to which you want to send the transcript questions and click OK. A link to the transcript and the transcript questions are displayed in the outline.

**INSERTING A WESTLAW DOCUMENT**

You can retrieve a document from the Witness Examination Outlines database (OUTLINES-ALL) on Westlaw and insert it into the outline on West Case Notebook.

To insert a document from Westlaw, complete these steps:

1. Click in the outline where you want to insert the Westlaw document.
2. Click the **Insert** button ( Insert ) on the toolbar above the outline and choose **Insert Westlaw Outline** from the menu. The Search Westlaw dialog box is displayed (Figure 10-8).

![Figure 10-8. Search Westlaw dialog box–Outlines tab](image)

3. By default, the table of contents for OUTLINES-ALL is displayed on the Outlines tab. To search the OUTLINES-ALL database,
   - browse the table of contents by clicking the plus (+) and minus (−) symbols, then select the check box next to the document you want to retrieve.
   - click **Template** to display a search template, then type your search terms in the text boxes. For further information on formulating a search, see “Working with Full Text Search” on page 73.

4. Click **Search Westlaw**. The Westlaw sign-on page is displayed.

5. Type your username and password in the text boxes. The client-matter information for the West Case Notebook case is entered for you in the **Client ID** text box. (To view the client-matter number for the case, choose **Case Properties** from the File menu in West Case Notebook.)

6. Click **Sign On** to display the Westlaw search result.
To send a document to West Case Notebook, click the **Export to Case Notebook** icon ( º) in the upper-right corner. The Export to Case Notebook page is displayed (Figure 10-9).

![Export to Case Notebook](image)

**Figure 10-9. Export to Case Notebook dialog box**

8. Click the **Show** arrow to add or remove a document element. Select or clear the check boxes for the elements you want to add or remove, then click the **Hide** arrow.

9. Make certain the matter number corresponds to the client-matter number for the case in West Case Notebook.

10. Choose an issue from the **Recent Categories** drop-down list, if desired.

11. Type a comment in the **Comments** text box, if desired.

12. Click **Save**. The Download Confirmation dialog box is displayed.

13. Click **Complete Download**. The File Download dialog box is displayed.

14. Click **Open**. The Data Import Wizard–Research Files dialog box is displayed.

15. Click **Finish**. The Select Outline dialog box is displayed.
16. Select the outline in which you want to insert the document and click OK. The document you selected is listed under Outlines in the left pane and the text of the document is displayed in the outline in the right pane (Figure 10-10).

![Figure 10-10. Outline with Westlaw document](image)

**Viewing Documents in an Outline**

To view a list of the documents that you inserted in an outline, click Outlines in the left pane, then double-click the outline containing the documents.

To jump to the place in the outline where you inserted a document, double-click the document in the left pane.

To view the source document, click the link for the document in the outline. The document is displayed in the right pane.

**Printing an Outline**

When you print an outline, you can also easily print the exhibits listed in the outline. To print an outline with listed exhibits, complete these steps:
1. Click the **Print** icon ( ) on the toolbar above the outline. The Print dialog box is displayed (Figure 10-11).

![Print dialog box](image)

Figure 10-11. Print dialog box

2. Choose a printer from the **Name** drop-down list.

3. To print the exhibits listed in your outline with annotations, type a number in the **Number of Copies** text box under **Exhibits–Annotated Work Product**.

   **Note** You must select the **Display Annotations** check box on the Annotations tab if you want to print annotations in exhibits. For further information, see steps 9–5 below.

4. Clear the **Include blank page between exhibits** check box, if desired.

5. Clear the **Include header** check box, if desired.

6. To print unannotated exhibits, type a number in the **Number of Copies** text box under **Exhibits–Originals**.

7. Select the **Include blank page between exhibits** check box, if desired.

8. Click the **Data** tab to display all document types and data included in the outline. By default, all document types and data are selected. To exclude a document type from being printed, clear its check box. To exclude particular data from being printed, select the document type containing the data, then clear the check boxes for the data you want to exclude.

9. Click the **Annotations** tab.

10. By default, the **Display Annotations** check box is selected. This must be selected if you want to print annotations in the exhibits.

11. To include or remove annotations associated with specific issues from the printed documents, click **Select Issues**. The Select Issues dialog box is displayed. (Issues will be listed in this dialog box only if they have previously been created. See “Working with Issues” on page 64.) Select or clear the check boxes next to the issues you want to include or remove and click **OK**. The Print dialog box is redisplayed.

12. Clear the **Include Annotations with no Issues** check box, if desired.

13. Clear the **Display Annotations in footer** check box, if desired.

14. Choose how you want the annotations displayed in the transcript text from the **Display** drop-down list.

15. Click **OK**.
**Opening an Existing Outline**
To open an outline, complete these steps:

1. If necessary, click **Outlines** in the left pane to display a list of all outlines in the case.
2. Double-click the outline you want to open. The text of the outline is displayed in the right pane.

**Deleting an Outline**
To delete an outline, right-click the outline in the left pane and choose **Delete** from the menu. The message *Permanently delete the selected outline?* is displayed. Click **Yes**.

**Closing an Outline**
To close an outline so that it is no longer displayed in the right pane, click the **Close** button ( ✗ ) on the outline’s tab.
11 Working with Issues

An issue is a type of annotation that relates to a particular subject. (For more information on annotations, see “Working with Annotations” on page 68.) Categorizing annotations in a case by issue makes it easy to retrieve all information on a specific subject when you need it. Issues are created for each case and are the same for all users of that case. When creating new issues, it is important to not duplicate previous issues.

Although the issues in a case are the same for all users, each user can choose the issues to display on the Main Menu toolbar. The Main Menu toolbar enables you to access issues quickly when creating annotations. You can display up to 10 issues on the Main Menu toolbar.

Creating Issues

To create an issue, complete these steps:

1. Click the Manage Issues button ( ) on the Main Menu toolbar. The Manage Issues dialog box is displayed (Figure 11-1).
2. Click New to display the New Issue dialog box.
3. Type the name of the issue, e.g., Work history, in the Issue text box.
4. Click the Color arrow to select a color for the issue, if desired.
5. Click Repeat if you are creating multiple issues.
6. When you finish creating issues, click Ok in the New Issue dialog box. The issues are listed under All Issues in the Manage Issues dialog box.

![Figure 11-1. Manage Issues dialog box]

CREATING SUB-ISSUES

You can create sub-issues, which are a subset of existing issues. You can add up to three levels of sub-issues.

To create a sub-issue, complete these steps:

1. Click the Manage Issues button ( ) on the Main Menu toolbar. The Manage Issues dialog box is displayed.
2. Click the # button ( ), if it is not already selected, to display numbers next to the issues (Figure 11-2).

![Figure 11-2. Manage Issues dialog box](image)

3. Under All Issues, select the issue, e.g. Work history, for which you want to create a sub-issue.
   
   **Note** If you do not select an issue, the sub-issue is added to the bottom of the list.

4. Click New to display the New Issue dialog box.

5. Type the name of the issue, e.g., Missed work, in the Issue text box.

6. Click the Color arrow to select a color for the issue, if desired.

7. Click Repeat if you are creating multiple sub-issues.

8. When you finish creating sub-issues, click OK in the New Issue dialog box. The sub-issues are listed under the issue you selected.

9. Select the sub-issue, if necessary, then click the Increase Indent button ( ). The sub-issue is indented under the issue and the sub-issue number becomes sequential to the issue number.

   To remove the sub-issue from under the issue, click the Decrease Indent button ( ).

**Prioritizing Issues**

To prioritize an issue or sub-issue and add it to the Main Menu toolbar, complete these steps:

1. Click the Manage Issues button on the Main Menu toolbar. The Manage Issues dialog box is displayed.

2. Select an issue or sub-issue under All Issues, e.g., Work history.

3. Click the left arrow to move the issue or sub-issue under My Top Issues.

4. Repeat steps 2 and 3 for each issue or sub-issue you want to prioritize and add to the Main Menu toolbar. You can prioritize up to 10 issues and sub-issues (Figure 11-3).

5. To reprioritize an issue or sub-issue and change its order on the Main Menu toolbar, select the issue or sub-issue under My Top Issues and click the up arrow or down arrow.
6. Click **OK** when you finish prioritizing the issues or sub-issues.

**Figure 11-3. Prioritizing issues**

**Importing Issues**

You can create a list of issues in any word-processing program that can save files as XML (Extensible Markup Language) files. To import issues and sub-issues from a file, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar, then choose **Issues (from File)** from the menu. The Open dialog box is displayed.
2. Select the file containing the issues you want to import and click **Open**.
3. The message **Issues were successfully imported from the chosen file** is displayed. Click **OK**.

**Exporting Issues**

To export issues to a file, complete these steps:

1. Choose **Save As, Issues** from the File menu. The Save As dialog box is displayed.
2. Select a location for the file.
3. Type a name for the file in the **File name** text box.
4. Choose a file type from the **Save as type** drop-down list.
5. Click **Save**.

**Creating an Issues Report**

This report lists all of the issues in a document, grouped by issue and then arranged in page and line order. To create an Issues report, complete these steps:
1. Click the **Report** button ( ) on the Main Menu toolbar, then choose **Issues** from the menu. The Issues Report Properties dialog box is displayed (Figure 11-4).

![Figure 11-4. Issues Report Properties dialog box](image)

2. All of the issues in the case are selected on the Issues tab by default. To remove an issue from the report, clear its check box.

3. Select the **Only include Annotations with all selected issues ("Match all Issues")** check box, if desired.

4. Select the **Only include Annotations that contain notes** check box, if desired.

5. Click the **Data** tab to display a list of all document types and data. By default, all document types and data are selected. To exclude a document type from the report, clear its check box. To exclude particular data from the report, click the document type containing the data, then clear the check boxes for the data you want to exclude.

6. Click the **Display** tab to view a list of display options. Type a title for the report in the **Title** text box, if desired. Then select or clear the appropriate check boxes.

7. Click the **Context** tab to display a list of context options. Select or clear the appropriate check boxes.

8. Click the **Authors** tab to display a list of annotation authors. If you are working in a secure case on a network, a list of all annotation authors is displayed. If you are working in the case offline, just **LocalUser** is displayed. Select or clear the appropriate check boxes.

9. Click **OK**. The Issues report, which includes the lines you marked and the surrounding questions and answers, is listed under **Report** in the left pane and the text of the report is displayed on the Report tab in the right pane.
12 Working with Annotations

An annotation is a highlighted portion of document text. It may be associated with an issue; a note (a comment associated with an annotation); or an attachment, e.g., a document or image.

**Adding an Issue Annotation Using the Main Menu Toolbar**
To add an annotation associated with an issue using the Main Menu toolbar, complete these steps:

1. Make certain the Apply Issue Mode button ( ) is displayed on the toolbar above the document in the right pane. To display the Apply Issue Mode button, click the **Annotate Mode** button ( ) on the toolbar above the document and choose **Apply Issue Mode** from the menu.
   
   **Note** The Annotate Mode button is the default button.

2. Click an issue button on the Main Menu toolbar to select the issue and assign it to the annotation you are adding.

3. Select the text you want to annotate. The text is highlighted with the color of the issue you selected (Figure 12-1). The issue will be assigned to every annotation you create until you cancel its selection on the Main Menu toolbar.
   
   **Note** You can select more than one issue on the Main Menu toolbar. Annotated text will be highlighted with the color of the last issue that you select.

![Figure 12-1. Annotated text](image)

**Adding an Annotation Using the Annotation Properties Dialog Box**
You can use the Annotation Properties dialog box to add an annotation associated with a note, issue, key fact, attachment, or a combination of these. To view the Annotation Properties dialog box, make certain the Annotate
Mode button ( ) is displayed on the toolbar above the document in the right pane. Then select the text in document you want to annotate. The Annotation Properties dialog box is displayed (Figure 12-2).

![Figure 12-2. Annotation Properties dialog box](image)

**ADDING A NOTE TO AN ANNOTATION**

The Note tab is the default tab in the Annotation Properties dialog box. To add a note to the annotated text, type the note in the Note text box and click OK.

**ADDING AN ISSUE TO AN ANNOTATION**

To associate an issue with an annotation, complete these steps:

1. Click the Issues tab in the Annotation Properties dialog box. A list of prioritized issues (those that appear on the Main Menu toolbar) is displayed under My Top Issues and a list of all issues is displayed under All Issues.
2. To assign one or more issues to the annotation, select the appropriate check boxes. Note that the check boxes for any issues you previously selected on the Main Menu toolbar are already selected.
3. Click OK. The annotated text is highlighted with the color of the issue you selected.

**ADDING A KEY FACT TO AN ANNOTATION**

To assign a key fact to an annotation, click the Key Facts tab in the Annotation Properties dialog box, select the key fact you want to assign to the annotation, and click OK.

**ADDING AN ATTACHMENT TO AN ANNOTATION**

To add an attachment to an annotation, complete these steps:

1. Click the paper clip icon ( ) in the Annotation Properties dialog box. The Edit Attachment dialog box is displayed.
2. Click Browse to display the Open dialog box is. Select your document and click Open. The Edit Attachment dialog box is redisplayed.
3. Click OK.
4. Click OK again in the Annotations Properties dialog box.

**ASSOCIATING VIDEO WITH AN ANNOTATION**

You can associate video with an annotation if the transcript has been synchronized with video footage. For further information, see “Working with Annotations and Video in Transcripts” on page 90.

**Transferring Annotations**

You can transfer an annotation to another application such as Microsoft Word, Corel WordPerfect, or TrialDirector using either of the following methods:
• Click **Send** in the Annotation Properties dialog box, then choose the application from the menu.
• Right-click in the annotation and choose **Send** from the menu, then choose the application from the submenu.

To transfer an annotation that is associated with a video to PowerPoint, see “Transferring Annotations to Microsoft PowerPoint” on page 90.

### Sending Annotations to Instant Messages

To send an annotation to a team member during an instant messaging session, complete these steps:

1. Click **Send** in the Annotation Properties dialog box, then choose **Realtime Chat** from the menu.
2. Click **OK**. The annotation is displayed in the **Annotation** text box under **Stream** in the left pane.
3. Click **Send** to send the annotation to your chat group. Or choose an individual from the **Send To** drop-down list and click **Send**.
4. Repeat steps 1–3 for each annotation you want to send (Figure 12-3).

![Figure 12-3. Sending an annotation to an instant message](image)

### Editing Annotations

To change the information associated with an annotation, right-click in the annotation and choose **Edit Annotation** from the menu. The Annotation Properties dialog box is displayed. Make the appropriate changes and click **OK**.

### Deleting Annotations

To delete an annotation, right-click in the annotation and choose **Delete Annotation** from the menu. The message **Permanently delete the selected Annotation?** is displayed. Click **Yes**.

### Viewing an Annotation Attachment

To view an annotation attachment, right-click in the annotation and choose **Open Attachment** from the menu.

### Creating an Annotations Report

You can generate a report that includes a list of all the annotations in a document, arranged in page and line order. It also includes the surrounding questions and answers.

To create an Annotations report for the document you are viewing, right-click the **Annotations** folder in the left pane and click **Report**. The report is listed under **Report** in the left pane and the text of the report is displayed on the Report tab in the right pane (Figure 12-4).
Click the Hit arrows in the left pane to view the next or previous annotation in the report. Click the heading next to a document icon in the report to go to the location in the document where the annotation appears.

To create an Annotations report for one or more documents, complete these steps:

1. Click the Report button ( ) on the Main Menu toolbar, then choose All Annotations from the menu. The All Annotations Report Properties dialog box is displayed (Figure 12-5).

2. All of the issues in the case are selected on the Issues tab by default. To exclude an issue from the report, clear its check box.

3. Clear the Include Quick Marks check box, if desired.
4. Clear the Include Annotations with no Issues check box, if desired.

5. Select the Only include Annotations with all selected issues (“Match all Issues”) check box, if desired.

6. Select the Only include Annotations that contain notes check box, if desired.

7. Click the Data tab to display a list of all document types and data. By default, all document types and data are selected. To exclude a document type from the report, clear its check box. To exclude particular data from the report, click the document type containing the data, then clear the check boxes for the data you want to exclude.

8. Click the Display tab to view a list of display options. Type a title for the report in the Title text box, if desired. Then select or clear the appropriate check boxes.

9. Click the Context tab to display a list of context options. Select or clear the appropriate check boxes.

10. Click the Authors tab to display a list of annotation authors. If you are working in a secure case on a network, a list of all annotation authors is displayed. If you are working in the case offline, just LocalUser is displayed. Select or clear the appropriate check boxes.

11. Click OK. The Annotations report, which includes the lines you marked and the surrounding questions and answers, is listed under Report in the left pane and the text of the report is displayed on the Report tab in the right pane.

CREATING A VERBATIM DIGEST REPORT

This is an Annotations report that includes only highlighted document text. To create a Verbatim Digest report, first create an Annotations report. Then click the Properties button (Properties) on the toolbar above the report in the right pane to display the All Annotations Report Properties dialog box. Click the Display tab and clear all check boxes under Annotations. Then, click the Context tab. Under Transcripts, select the Show annotated text check box and clear the Additional context check box, then click OK.

CREATING A NOTES REPORT

This report lists all of the annotations in a document that have a note, arranged in page and line order. To create a Notes report, first create an Annotations report. Then click the Properties button (Properties) on the toolbar above the report in the right pane to display the All Annotations Report Properties dialog box. On the Issues tab, select the Only include Annotations that contain notes check box and click OK.

CREATING AN ATTACHMENTS REPORT

This report lists all of the annotations in a document that have an attachment, arranged in page and line order. To create an Attachments report, first create an Annotations report. Then click the Properties button (Properties) on the toolbar above the report in the right pane to display the All Annotations Report Properties dialog box. On the Issues tab, clear the Include Quick Marks check box. Then click the Display tab. Clear all check boxes under Annotations except the Attachments check box, then click OK.
13 Working with Full Text Search

The Full Text Search feature enables you to search one or more documents in the open case for specific terms.

Creating a Full Text Search

You can enter a search that consists of key terms from your issue and connectors specifying the relationship between those terms. To create a search, complete these steps:

1. From the Search menu, choose Full Text Search. The Full Text Search Properties dialog box is displayed (Figure 13-1).

![Figure 13-1. Full Text Search Properties dialog box](image)

2. Formulate your search by choosing search terms significant to your issue and deciding which connectors to place between your terms. To retrieve variations of terms, use the root expander (!) and the universal character (*). To retrieve a phrase, place quotations marks (" ") around the phrase.

For more information on creating a search, see “Formatting a Full Text Search” on page 74.

3. Type your search, e.g., **document /20 handwritten**, in the Terms text box. Or choose a search from the Recent drop-down list.

4. Click the Data tab to display all document types and data. By default, all document types and data are selected. To exclude a document type from the search, clear its check box. To exclude particular data from your search, click the document type containing the data, then clear the check boxes for the data you want to exclude.
5. Click **OK**. Information about the search is displayed under **Search Results** in the left pane (Figure 13-2).

![Figure 13-2. Full Text Search result](image)

**Formatting a Full Text Search**

**USING THE ROOT EXPANDER**

Use the root expander (!) to retrieve words with variant endings. The root expander must always be placed at the end of a term. For example,

<table>
<thead>
<tr>
<th>Type</th>
<th>To retrieve</th>
</tr>
</thead>
<tbody>
<tr>
<td>contribut!</td>
<td>contribute</td>
</tr>
<tr>
<td></td>
<td>contributed</td>
</tr>
<tr>
<td></td>
<td>contributor</td>
</tr>
<tr>
<td></td>
<td>contributing</td>
</tr>
<tr>
<td></td>
<td>contribution</td>
</tr>
<tr>
<td></td>
<td>contributory</td>
</tr>
</tbody>
</table>

Plurals and possessive forms are automatically retrieved without a root expander.

**USING THE UNIVERSAL CHARACTER**

Use the universal character (*) to represent one variable character. You can place the universal character anywhere in a term except at the beginning. For example,

<table>
<thead>
<tr>
<th>Type</th>
<th>To retrieve</th>
</tr>
</thead>
<tbody>
<tr>
<td>gr*w</td>
<td>grew</td>
</tr>
<tr>
<td></td>
<td>grow</td>
</tr>
</tbody>
</table>

**Note** When you place one or more universal characters at the end of a term, you specify the maximum length of that term.
USING CONNECTORS

Use connectors to specify the relationships that should exist between search terms in your retrieved documents.

<table>
<thead>
<tr>
<th>Type</th>
<th>To search for documents that contain</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp; (AND)</td>
<td>both terms</td>
</tr>
<tr>
<td>a space (OR)</td>
<td>either term or both terms</td>
</tr>
<tr>
<td>/n</td>
<td>terms within n terms of each other (where n is a number)</td>
</tr>
<tr>
<td>+n</td>
<td>the first term preceding the second by n terms (where n is a number)</td>
</tr>
<tr>
<td>“ ”</td>
<td>terms appearing in the same order as in the quotation marks</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>To exclude documents that contain</th>
</tr>
</thead>
<tbody>
<tr>
<td>% (BUT NOT)</td>
<td>the terms following the percent symbol</td>
</tr>
</tbody>
</table>

Creating a Search Report

This report lists the results retrieved when you run a search using the Full Text Search feature. To create a Search report, click the Report button ( Report ) on the Main Menu toolbar, then choose Full Text Search from the menu. See “Working with Full Text Search” on page 73 for information on running searches.
14 Working with Auto Tags

Use Auto Tags to automatically highlight words or phrases as they appear in a document.

Creating Auto Tags

To create an Auto Tag, complete these steps:

1. Choose **Auto Tags** from the Annotate menu. The Auto Tags dialog box is displayed (Figure 14-1).

![Figure 14-1. Auto Tags dialog box](image)

2. Click **New**. Then type the word or phrase you want to add to the Auto Tags list.
3. Select the **Show Auto Tags** check box to highlight Auto Tags in the document.
4. Click the **Color** arrow to select a color, if desired.
5. Click **OK** to save your changes. Your Auto Tags will be highlighted automatically throughout the document (Figure 14-2).

![Figure 14-2. Auto Tags](image)

Managing Auto Tags

SHOWING AND HIDING AUTO TAGS

If you choose not to show Auto Tags when you create them, you can show them by choosing **Auto Tags** from the Annotate menu. The Auto Tags dialog box is displayed. Select the **Show Auto Tags** check box and click **OK**. To hide Auto Tags, clear the **Show Auto Tags** check box.

DELETING AUTO TAGS

To delete an Auto Tag, complete these steps:

1. From the Annotate menu, choose **Auto Tags** to display the Auto Tags dialog box.
2. Select the Auto Tag you want to remove and click **Delete**.
3. Repeat step 2 for each Auto Tag you want to delete.
4. Click **OK** to save your changes.

**Creating an Auto Tag Report**

This report lists all occurrences of the words and phrases in a transcript for which Auto Tags were created, arranged in page and line order. To create an Auto Tag report, complete these steps:

1. Click the **Report** button ( ) on the Main Menu toolbar, then choose **Auto Tags** from the menu. The Auto Tag Report Properties dialog box is displayed (Figure 14-3).

![Figure 14-3. Auto Tag Report Properties dialog box](image)

2. Click the **Data** tab to display a list of all document types and data. By default, all document types and data are selected. To exclude a document type from the report, clear its check box. To exclude particular data from the report, click the document type containing the data, then clear the check boxes for the data you want to exclude.

3. Click the **Display** tab to view a list of display options. Type a title for the report in the **Title** text box, if desired. Then select or clear the appropriate check boxes.

4. Click the **Context** tab to display a list of context options. Select or clear the appropriate check boxes.

5. Click **OK**. The Auto Tag report, which includes the lines with the Auto Tags and the surrounding questions and answers, is listed under **Report** in the left pane and the text of the report is displayed on the Report tab in the right pane.
15 Working with Data Groups

You can organize document types and data into groups. For example, you can create groups based on the different types of witnesses in a case, such as character witnesses and expert witnesses. When you assign data to a group, the data is displayed under the group folder in the left pane (Figure 15-1). You can also select a group when you are preparing reports or creating searches to ensure all the document types and data you need are included.

![Figure 15-1. Documents organized into data groups](image)

Creating a Data Group

To create a data group, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar, then choose **Data Group** from the menu. The Data Group Properties dialog box is displayed (Figure 15-2).

![Figure 15-2. Data Group Properties dialog box](image)

2. Type the name of the group, e.g., **Character witnesses**, in the **Name** text box.

3. By default, all document types and data are selected. To exclude a document type from the group, clear its check box. To exclude particular data from the group, click the document type containing the data, then clear the check boxes for the data you want to exclude.

4. Click **OK**.
Editing Data Groups
To add document types and data to a group or remove them from a group, complete these steps:

1. From the Tools menu, choose Manage Data Groups. The Data Groups dialog box is displayed.
2. Select the group you want to edit and click Edit. The Data Group Properties dialog box is displayed.
3. Select or clear the appropriate check boxes and click OK.
4. Click OK again in the Data Groups dialog box.

Using Data Groups in Reports
To create a report using data groups, complete these steps:

1. Click the Report button ( ) on the Main Menu toolbar, then choose the type of report you want to create, e.g., Issues.
2. In the dialog box that is displayed, click the Data tab, then click Groups. The Data Groups dialog box is displayed.
3. Select the group or groups you want to include in the report and click OK.
4. Click OK again to create the report.

Using Data Groups in Full Text Searches
You can run full text searches using data groups. To conduct a search using data groups, complete these steps:

1. From the Search menu, choose Full Text Search. The Full Text Search Properties dialog box is displayed.
2. Type a search in the Terms text box, or choose a search from the Recent drop-down list.
3. Click the Data tab, then click Groups. The Data Groups dialog box is displayed.
4. Select the group or groups you want to include in the search and click OK. The Full Text Search Properties dialog box is redisplayed.
5. Click OK to run the search.
See “Working with Full Text Search” on page 73 for more information on using the Full Text Search feature.

Sorting by Data Groups
Use the Sort by Data Groups feature to view transcripts, documents, pleadings, and research documents sorted by data groups. For example, to view documents listed in the data groups, click Documents in the left pane, then click the arrow next to Sort By Title and choose Sort By Data Groups from the menu. The documents are listed in the data group folders to which they were assigned.
16 Transferring Document Text

You can copy text or a portion of a document and paste it into an outline in West Case Notebook or other applications. For each document type, you will need to make certain that the appropriate button used for copying text is displayed. To display the button, click the arrow next to the Annotate Mode button ( ) on the toolbar above the document in the right pane, then choose the appropriate button from the menu (Figure 16-1), as discussed below. The menu choices will vary depending on the document type you are viewing.

![Copy buttons](image)

Figure 16-1. Copy buttons

Transferring Text of a Transcript

When viewing a transcript, you can transfer the following details with the text:

- page number (or numbers if copied text spans more than one page)
- line numbers

To transfer transcript text with page and line numbers, complete these steps:

1. Make certain the **Copy (with Page and Line)** button ( ) is displayed.
2. Select the text you want to copy.
3. Open an outline in West Case Notebook or open another application and paste the text you have copied. For example, to paste the text into Microsoft Word, press **Ctrl+V** or choose **Paste** from the Edit menu in Word.

Transferring Text of a Document or Pleading

To transfer the text of a document or pleading that is a word-processing document, complete these steps:

1. Make certain the **Copy** button ( ) is displayed.
2. Select the text you want to copy.
3. Open an outline in West Case Notebook or open another application and paste the text you have copied. For example, to paste the text into Microsoft Word, press **Ctrl+V** or choose **Paste** from the Edit menu in Word.

If you are viewing a document or pleading that is an image file or PDF file, you can transfer a portion of the document or pleading. To transfer a portion of a document or pleading, complete the following steps:

1. Make certain the **Select Mode** button ( ) is displayed.
2. Select the portion of the document you want to copy.
3. Choose **Copy** from the Edit menu.
4. Open an outline in West Case Notebook or open another application and paste the text you have copied. For example, to paste the text into Microsoft Word, press **Ctrl+V** or choose **Paste** from the Edit menu in Word.
Transferring Text of a Westlaw Document

If you are viewing a Westlaw document, you can transfer the citation with the text. To transfer text with its citation, complete these steps:

1. Make certain the **Copy (with Citation)** button (ï»•) is displayed.
2. Select the text you want to copy.
3. Open an outline in West Case Notebook or open another application and paste the text you have copied. For example, to paste the text into Microsoft Word, press Ctrl+V or choose Paste from the Edit menu in Word.
The Word Index contains an index of words and numbers in a document along with their corresponding page and line numbers (Figure 17-1). When you are connected to Realtime, the Word Index is updated every 15 seconds. Use the Word Index to search for a term in the document. Type the term in the text box to the right of the document to display the pages and lines where the term is found in the document.

To see the term in context, point to the page and line reference. The question and answer in which the term appears is displayed.

**Note** If you do not see the question and answer in which the term appears, you must change the Word Index display options. For further information, see “Selecting Word Index Display Options” below.

To display the term in the document, click the page and line reference.

**Selecting Word Index Display Options**

To select Word Index display options, choose **Display Options** from the View menu to display the Display Options dialog box (Figure 17-2). Click the **Word Index** tab. You can specify

- whether you want to see your term in context when you point to the page and line reference in the Word Index
- how much document text you want displayed when viewing a term in context in the Word Index. If you select **QA Pair**, the entire question and answer in which the term appears is displayed. In the alternative, you can designate the number of lines to be displayed above and below the term
- the types of documents in which to display the Word Index
Click **OK** to save the Word Index display options.

![Display Options dialog box](image)

Figure 17-2. Display Options dialog box
Connecting with a Serial Connection

If you want to connect to Realtime using serial cables, your computer must have a serial port. If you have only a USB port available, you will need to provide a USB to serial adapter. (For information about serial adapters, download a free copy of Connecting to Realtime: West Case Notebook/West LiveNote at west.thomson.com/support/user-guide/livenote-case-notebook.aspx.) If a USB to serial adapter is not available, you can connect to Realtime over the Internet via LiveNote Stream. Contact the court reporter to schedule the session.

To connect to Realtime using serial cables, complete these steps:

1. Click the New arrow on the Main Menu toolbar, then choose Realtime Transcript from the menu. The Connect to Realtime dialog box is displayed (Figure 18-1).

2. Select Serial. The court reporter will give you the necessary settings for connecting to the reporter’s CAT (computer-aided transcription) system. You will need to know the required serial port setting.

3. Click Connect to connect to Realtime.

Using LiveNote Stream

LiveNote Stream allows you to connect to Realtime via the Internet. You can access LiveNote Stream through West Case Notebook software or through Microsoft Internet Explorer.

The court reporter must schedule the session 24 hours in advance if you want to use LiveNote Stream to view transcript text or 72 hours in advance to view video and text. LiveNote Central will send you an e-mail with the required username and password.

Note In order to view the video segment, you must use Internet Explorer and Windows Media Player 9 or later. You must also unblock pop-up windows.
ACCESSING LIVENOTE STREAM THROUGH WEST CASE NOTEBOOK

To connect to Realtime using LiveNote Stream through West Case Notebook, complete these steps:

1. Click the **New** arrow on the Main Menu toolbar, then choose **Realtime Transcript** from the menu. The Connect to Realtime dialog box is displayed (Figure 18-2).

![Figure 18-2. Connect to Realtime dialog box](image)

2. Select **LiveNote Stream**.
3. Select the check box next to **Play live video (if available)**.
4. Click **Connect** to display the LiveNote Stream Login dialog box.
5. Type the username and password sent to you by LiveNote Central and click **OK** to display the Connect to LiveNote Stream dialog box.
6. Select the session you want to attend and click **OK**.

ACCESSING LIVENOTE STREAM THROUGH INTERNET EXPLORER

You do not need West Case Notebook software to access LiveNote Stream through Internet Explorer.

To access LiveNote Stream through Internet Explorer, complete these steps:

2. Type the username and password sent to you by LiveNote and click **Go** to display a list of your sessions.
3. Select the session you want to attend and click Go. The Realtime transcript text and video are displayed (Figure 18-3).

Figure 18-3. LiveNote Stream

ACCESS TO FEATURES IN LIVENOTE STREAM

When you view access LiveNote Stream using Internet Explorer, you are able to hear the audio and see the video and streaming transcript text. You can also stop and start the transcript text. When you access LiveNote Stream using West Case Notebook software, you have access to all the tools in West Case Notebook. Below is a chart showing the features available with LiveNote Stream.

<table>
<thead>
<tr>
<th>West Case Notebook Features</th>
<th>LiveNote Stream Through Internet Explorer</th>
<th>LiveNote Stream Through West Case Notebook</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Video</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Instant messaging</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Streaming transcript text</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Start and stop text</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Word Index</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Saved transcript</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Quick Marks</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Issue Marks</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Annotations</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Auto Tags</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Full Text Search</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Reports</td>
<td>■</td>
<td>■</td>
</tr>
</tbody>
</table>
West Case Notebook provides you with tools that are easy to use even when you are working with a transcript in Realtime. You can stop and start the scrolling text, annotate the text, and do quick word searches at the same time that you are listening to what the deponent or witness is saying. You can also annotate and search existing transcripts.

**Starting and Stopping Text**

To stop the scrolling transcript (Figure 19-1),

- click **Pause** on the toolbar above the transcript
- press the **Esc** key

To browse the text of the transcript,

- use the scroll bar on the right
- press the **Page Up** and **Page Down** keys
- press the arrow keys
- press **Ctrl+Home** to go to the top of the text
- press **Ctrl+End** to go to the end of the text

To restart the scrolling transcript,

- click **Pause**
- press the **Esc** key

**Using Quick Marks**

Quick Marks are marks at the line number in the margin of a transcript. They are the simplest form of annotation in West Case Notebook and are displayed as a solid bar in the default Quick Mark color. You can use them as place markers in the text for which you can run searches and generate reports.

To insert a Quick Mark (Figure 19-2)

- press the spacebar on your keyboard
- click a line number

A complete list of all Quick Marks in a transcript is located in the Annotations folder under the transcript in the left pane. Click the plus symbol (+) next to the transcript to view the Annotations folder. Double-click a Quick Mark reference in the folder to jump to the Quick Mark in the transcript.
To delete a Quick Mark, click it in the margin of the transcript.

![Figure 19-2. Quick Mark](image)

**Quick Marks Report**

This report lists all Quick Marks and Issue Marks in a transcript, arranged in page and line order.

To create a Quick Marks report for the transcript you are viewing, click the **Quick Mark Report** button ( ) on the toolbar above the transcript in the right pane. The report is displayed on the Report tab in the right pane.

To create a Quick Marks report for one or more transcripts, complete these steps:

1. Click the **Report** button ( ) on the Main Menu toolbar, then choose **Quick Marks**. The Quick Mark Report Options dialog box is displayed (Figure 19-3).

![Figure 19-3. Quick Mark Report Options dialog box](image)

2. All of the issues in the case are selected on the Issues tab by default. To exclude an issue from the report, clear its check box.

3. Click the **Data** tab to display a list of transcripts. By default, all transcripts are selected. To exclude a transcript from the report, clear its check box.

4. Click the **Display** tab to view a list of display options. Type a title for the report in the **Title** text box, if desired. Then select or clear the appropriate check boxes.

5. Click the **Context** tab to display a list of context options. Select or clear the appropriate check boxes.

6. Click the **Authors** tab to display a list of annotation authors. If you are working in a secure case on a network, a list of all annotation authors is displayed. If you are working in the case offline, just LocalUser is displayed. Select or clear the appropriate check boxes.
7. Click **OK**. The Quick Marks report, which includes the lines you marked and the surrounding questions and answers, is displayed on the Report tab in the right pane.

**Using Issue Marks**

An Issue Mark is a mark at the page and line number in the margin of a transcript that corresponds to a particular issue on the Main Menu toolbar. The Issue Mark color is the same as the color of the issue. To insert an Issue Mark, click an issue button on the Main Menu toolbar, then click a line number (Figure 19-4).

A complete list of all Issue Marks is located in the Annotations folder in the left pane. Click the plus symbol (+) next to the transcript to view the Annotations folder. Double-click an Issue Mark reference in the folder to jump to the Issue Mark in the transcript.

To delete an Issue Mark, click it in the margin of the transcript.
20 Working with Annotations and Video in Transcripts

Playing Annotation Video Segments
If the transcript you are viewing has a video associated with it, you can view the portion of the video that is synchronized with an annotation. To view the video, right-click anywhere in the annotation, then choose Play Video Segment from the menu.

Creating Annotation Video Segments
If a transcript has been synchronized with video, you can convert the transcript text to a video segment and save it. You can create a single video segment from a single annotation or create multiple video segments from an Annotations report.

CREATING A VIDEO SEGMENT FROM A SINGLE ANNOTATION
To create a single video segment from an annotation, complete these steps:
1. Double-click an annotation in the left pane. The highlighted text of the annotation is displayed in the right pane.
2. Right-click in the annotation.
3. From the menu that is displayed, choose Send. Then choose Video File from the submenu. The Save As dialog box is displayed.
4. Select a location for the file.
5. Type a different file name in the File name text box, if desired.
6. Click Save. The message Would you like to view the new video clip now? is displayed.
7. Click Yes to view the video segment.

CREATING MULTIPLE VIDEO SEGMENTS FROM AN ANNOTATIONS REPORT
To create multiple video segments from an Annotations report, complete these steps:
1. In the left pane, right-click the Annotations folder, then click Report. The Annotations report is displayed on the Report tab in the right pane.
2. Click Send at the top of the report, then choose Video File from the menu. The Save As dialog box is displayed.
3. Select a location for the file.
4. Type a different file name in the File name text box, if desired.
5. Click Save. The message Video files saved successfully. Would you like to open the containing folder now? is displayed.
6. Click Yes to open the folder in which the video segments are stored. The page and line ranges are added to the video segments.

Transferring Annotations to Microsoft PowerPoint
You can transfer annotations and video segments to Microsoft PowerPoint and have them embedded in PowerPoint slides. Each annotation creates a separate slide. You can create a slide from a single annotation or multiple slides from an Annotations report.
Note It is recommended that you use short annotations for each PowerPoint slide. If you need a longer excerpt, transfer multiple annotations from a report to create a single PowerPoint presentation with a slide for each annotation.

Also, when you transfer annotations to PowerPoint from transcripts with associated videos, you have the option of saving both the PowerPoint file (PPT) and the video clip (WMV). If you want to share the PowerPoint presentation with someone else, you must include the associated WMV file for the embedded video to play.

CREATING A POWERPOINT PRESENTATION FROM A SINGLE ANNOTATION
To create a PowerPoint presentation from an annotation, complete these steps:

1. Double-click an annotation in the left pane. The highlighted text of the annotation is displayed in the right pane.
2. Right-click in the annotation and choose Send from the menu and PowerPoint from the submenu. The Save As dialog box is displayed.
3. Select a location for the file.
4. Type a different file name in the File name text box, if desired.
5. Click Save. The message Would you like to open the presentation now? is displayed.
6. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close PowerPoint.

CREATING A POWERPOINT PRESENTATION FROM AN ANNOTATIONS REPORT
To create a PowerPoint presentation from an Annotations report, complete these steps:

1. In the left pane, right-click the Annotations folder, then click Report. The Annotations report is displayed on the Report tab in the right pane.
2. Click Send at the top of the report, then choose PowerPoint from the menu. The Save As dialog box is displayed.
3. Select a location for the file.
4. Type a different name for the file in the File name text box, if desired.
5. Click Save. The message Would you like to open the presentation now? is displayed.
6. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close PowerPoint.

SAVING POWERPOINT FILES WITH THE SAME NAME
If you save a PowerPoint file with a name that already exists, the Existing PowerPoint File dialog box is displayed. Select Append slides to existing presentation to add slides to the existing presentation.
Using Issues to Create an Errata Report

The deponent has the option of reviewing the transcript after the deposition. If the deponent finds errors in the transcript, you can easily mark those places in the transcript and create an Errata report. To create an Errata report, complete these steps:

1. Create an issue named **Errata** (see “Working with Issues” on page 64) and prioritize it to add it to the Main Menu toolbar.

2. Make certain the **Annotate Mode** button ( ) is displayed on the toolbar above the transcript in the right pane.

3. Click the **Errata** button on the Main Menu toolbar to select it.

4. Select the text in the transcript that the deponent reports is in error. The Annotation Properties dialog box is displayed.

5. Type any information regarding the error in the **Note** text box, e.g., **Witness says name should be Joan, not John.** Click **OK**.

6. Right-click the **Annotations** folder under the transcript in the left pane and click **Report**. The report is listed under **Report** in the left pane and the text of the report is displayed on the Report tab in the right pane.

7. Click the **Properties** button ( ) on the toolbar above the report in the right pane to display the All Annotations Report Properties dialog box.

8. On the Issues tab, clear all check boxes except the **Errata** check box.

9. Select the **Only include Annotations with all selected issues ("Match all Issues")** check box.

10. Click **OK**. The report is redisplayed on the Report tab in the right pane with only the Errata annotations.
**Converting RealLegal Binder Cases to West Case Notebook Cases**

When you open a RealLegal Binder case in West Case Notebook, the properties for the case may or may not be converted. The following chart describes how the RealLegal Binder case properties are converted.

<table>
<thead>
<tr>
<th>ITEMS THAT ARE CONVERTED</th>
<th>ITEMS THAT ARE NOT CONVERTED</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Transcripts</strong></td>
<td></td>
</tr>
<tr>
<td>• transcript text</td>
<td>• transcript properties: Time, Plaintiff, Defendant</td>
</tr>
<tr>
<td>• transcript properties: Type, Status, Last, First, Volume, Date, Title, Taking Attorney, For, Comment</td>
<td></td>
</tr>
<tr>
<td>• links to documents from transcripts</td>
<td></td>
</tr>
<tr>
<td>• signature for signed transcripts (version 7.0 and later)</td>
<td></td>
</tr>
<tr>
<td>• video sync information</td>
<td></td>
</tr>
<tr>
<td><strong>Documents</strong></td>
<td></td>
</tr>
<tr>
<td>• document contents</td>
<td>• document properties: Title</td>
</tr>
<tr>
<td>• document properties: Type, Author, Recipient, Bates Range, Date, OCR information</td>
<td>• exhibit check box data, exhibit number, exhibit prefix</td>
</tr>
<tr>
<td><strong>Annotations</strong></td>
<td></td>
</tr>
<tr>
<td>• all annotations</td>
<td>• chronology date</td>
</tr>
<tr>
<td>• issues, including name and color</td>
<td>• active issue properties</td>
</tr>
<tr>
<td>• attachment URLs are preserved</td>
<td>• annotations authors only converted when imported into a secure case</td>
</tr>
<tr>
<td>• comments converted to notes</td>
<td></td>
</tr>
<tr>
<td><strong>Search groups</strong></td>
<td></td>
</tr>
<tr>
<td>• search groups converted to data groups</td>
<td>• preprogrammed search groups that come with RealLegal Binder</td>
</tr>
<tr>
<td>• search group name converted to data group title</td>
<td>• saved reports</td>
</tr>
<tr>
<td>• transcripts and documents from the search group converted to data group</td>
<td></td>
</tr>
</tbody>
</table>
**Prompts and Messages for Video and PowerPoint**

You may receive the following warnings and error messages when transferring files as video or to PowerPoint.

**The file [PowerPoint file name] already exists. Do you want to append slides to existing presentation [or] overwrite existing file?**

In most cases you will want to append or add slides to the existing PowerPoint presentation. Refer to “Transferring Annotations to Microsoft PowerPoint” on page 90 for more information.

**The file is open in PowerPoint. Please close PowerPoint and retry.**

PowerPoint needs to be closed when you are creating a presentation or appending slides to an existing presentation.

**The folder already contains file named [video file name]. Would you like to replace this file?**

This error usually occurs when you try to transfer the same annotation twice or when you try to save over an existing PowerPoint presentation. If you do not want to replace the file, you can cancel the transfer and review the annotation to make sure nothing has changed and then resave the file, or you can save the file to a different folder.

**Synchronized video is not associated with this transcript.**

The video has not been synchronized with the transcript. A synchronized video is a video that plays in sync with the transcript; i.e., as the person in the video speaks, the transcript scrolls and highlights the spoken text. A utility (e.g., RealLegal Publisher) must be used to synchronize the video with the transcript; otherwise, the video plays but the transcript does not scroll.

**Video does not exist for this transcript.**

No video is associated with the transcript. You can transfer an annotation to PowerPoint, but not video.

**Cannot create clip from annotation that spans more than one file.**

This is a catchall error message designed for unsupported scenarios. Please contact West LiveNote Customer Technical Support at 1-800-290-WEST (1-800-290-9378) and describe what you were doing when this error occurred.

**Video clips can only be created from MPEG and WMV video files.**

West Case Notebook only supports specific types of video files. For example, you cannot create video clips from RM (Real) or AVI (Audio Video Interleave) files.

**Failed to create temporary PowerPoint template file! Error code %d.**

This error may occur when your hard drive is full or if you do not have access rights to the hard drive where you are attempting to transfer the file.

**In order to create PowerPoint slides, you must first install PowerPoint on this computer.**

PowerPoint must be installed before you can transfer annotations to PowerPoint.
Connecting to a Simulated Realtime Transcript

When West Case Notebook is installed, it provides you with a demonstration case, which includes sample deposition transcripts, exhibits, preset issues, and simulation of a real-time deposition. You can use the simulated transcript to practice using the basic tools of West Case Notebook.

To access the simulation, complete these steps:

1. Access West Case Notebook.
2. When the Open Case dialog box is displayed, select Gil Bower v. DC Corporation and click OK. The case window is displayed.
3. Click the New arrow on the Main Menu toolbar, then choose Realtime Transcript from the menu. The Connect to Realtime dialog box is displayed (Figure 0-1).
4. Select Simulation, then click Connect. The deposition automatically begins transcribing in the right pane.

**Note** The transcript is titled Realtime by default and listed under Transcripts in the left pane. To change the title of the transcript, right-click it and choose Properties from the menu. The Transcript Properties dialog box is displayed. Type a different title for the transcript in the Title text box and click OK.
**Trial Version of West Case Notebook**

West Case Notebook offers a trial version of its software. In the trial version, you can

- connect to 15 Realtime sessions
- add up to three transcripts, 10 documents, five pleadings, 10 research files, 25 key facts, and 10 characters
- create Issue Marks, Quick Marks, and annotations
- use the Word Index, Auto Tags, and Full Text Search (not available for some file formats added to the trial version)
- insert exhibits, transcript questions, and Westlaw documents into an outline
- send key facts to West Case Timeline, Microsoft Word, or Corel WordPerfect
- generate reports

In the trial version, you cannot

- update transcripts, documents, pleadings, and research files
- create outlines
- delete any items from the demonstration case
- save transcripts as ASCII files
- create a new case
- close the current case and open another case
- export cases
- connect to the West LiveNote Repository

**Notes**

- A transcript printed from the trial version includes a Demo watermark.
- Optical character recognition (OCR) technology is not available in the trial version of West Case Notebook.
Index

A
adding
  annotations using Annotation Properties dialog box 68–69
  attachments to annotations 69
characters
  automatically 48–49
  by adding smart tags 49–50
  by changing the properties of transcripts, documents, and pleadings 48–49
  by creating 47–48
  by importing from CSV file 48
  by importing transcripts, documents, and pleadings 49 manually 47–48
issue annotations using Main Menu toolbar 68
issues to annotations 69
issues to Main Menu toolbar 64–66
key facts to annotations 69
notes to annotations 69
smart tags manually 50
video to annotations 69
aliases 50–51
ampersand (&). See AND connector
AND connector 75
annotations
  adding
    attachments 69
    issues 69
    key facts 69
    notes 69
    using the Annotations Properties dialog box 68
    using the Main Menu toolbar 68
  associating video 69
  attachments report 72
  creating video segments from 90
deleting 70
  editing 70
  folder 70, 87, 89, 90, 91
  notes report 72
  playing video segments 90
  reports 70–72
  sending to instant messages 70
  transferring to
    another application 69
    Microsoft PowerPoint 91
  verbatim digest report 72
  viewing attachments 70
ASCII files 19
asterisk (*). See universal character
attachments report 72
Auto Tags
  creating 76
deleting 76
  hiding 76
  reports 77
  showing 76
B
  BUT NOT (&) connector 75
C
cases
  creating from open case 4
  icons
    brown 6
    brown and blue 6
  importing 4
  local
    creating 3
    opening 4
    new 3
  opening RealLegal Binder cases 4
  replicating
    individual
      offline 7–8
      to the network 8
    multiple
      offline 8–9
      to the network 10
  replication options, changing 10
  reports 11–12
  secure
    accessing 4–6
    favorite 7
    remote access 6
characters
  about 47
  adding automatically 48–49
  adding by
    adding smart tags 49–50
    changing the properties of transcripts, documents, and pleadings 48–49
    creating 47–48
    importing from CSV file 48
    importing transcripts, documents, and pleadings 49
  adding manually 47–48
  aliases 50–51
  closing tab 53
deleting 53
  editing 53
  exporting 53
  reports 52–53
  retrieving profile from Westlaw 51–52
smart tags 49–50

closing
  Characters tab 53
  documents 28
  Key Facts tab 45
  outlines 63
  pleadings 32
  transcripts 16

collectors 75

copying text 80–81
Corel WordPerfect
  exporting key facts to 45
  transferring annotations to 69

creating
  Auto Tags 76
  cases 3–4
  characters 47–48
  data groups 78
  Full Text Search 73–74
  issues 64
  key facts 43–44
  Microsoft PowerPoint presentation 91
  outlines 54–55
  sub-issues 64–65
  video segments from annotations 90

D

data groups
  about 78
  creating 78
  editing 79
  in reports 79
  searching with 79
  sorting by 79

deleting
  annotations 70
  Auto Tags 76
  characters 53
  documents 28
  key facts 45
  outlines 63
  pleadings 32
  transcripts 17
  transcript summaries 16

documents
  closing 28
  deleting 28
  importing
    file types 2
    individual files 22–23
    load files 24–26
    multiple files 23–24
    Westlaw documents 41–42
  inserting text into outline 55

opening 28
  sending to West Case Notebook
    from Microsoft Outlook 27–28
    using Windows Explorer 26
  transferring text 80

E

editing
  annotations 70
  characters 53
  data groups 79
  key facts 45
  exclamation point (!). See root expander

exporting
  characters 53
  issues 66
  WestlawNext research 39
  Westlaw research 35

F

favorite cases 7

file types for importing 1–2

folders
  annotations 70, 87, 89, 90, 91
  Issue Marks 89
  Quick Marks 87

Full Text Search
  creating 73–74
  formatting 74

I

importing
  cases 4
  documents 22–24
  file types 1, 2
  issues 66
  load files 24
  pleadings 29–30
  transcripts 13
  Westlaw documents 41–42

instant messages, sending annotations to 70

Internet connection to Realtime 84–86

Internet Explorer, accessing LiveNote Stream through 85

Issue Marks 89

issues
  adding to Main Menu toolbar 64–66
  creating 64
  exporting 66
  importing 66
  prioritizing 64–66
  reports 66–67
  sub-issues 64–65
K
KeyCite 40
key facts
  closing tab 45
  creating 43–44
  deleting 45
  editing 45
  reports 44–45
  saving as West Case Timeline file 46
  sending to
    Corel WordPerfect 45
    Microsoft Word 45
    West Case Timeline 45–46

L
LiveNote Evidence Format (LEF) files 20
LiveNote Stream
  about 84
  accessing
    through Internet Explorer 85
    through West Case Notebook 85
  features 86
  load files, importing 24–26
  local case
    creating 3
    opening 4

M
Microsoft Outlook
  sending documents from 27–28
  sending pleadings from 31–32
Microsoft PowerPoint presentations 91
Microsoft Word
  sending key facts to 45
  transferring annotations to 69
  transferring document text to 80
  transferring transcript text to 80

N
notes report 72
numerical connector (/n, +n) 75

O
opening
  documents 28
  local cases 4
  outlines 63
  pleadings 32
  RealLegal Binder cases 4
  secure cases 4
  transcripts 14
  transcript summaries 16
  OR connector (space) 75
  outlines
closing 63
creating 54–55
deleting 63
inserting
  document text 55
  potential exhibits 56–57
  reports 55–56
  transcript questions 57–58
  typed text 55
opening 63
printing 61–62
viewing documents 61

P
pleadings
  closing 32
  deleting 32
  importing
    file types 2
    individual files 29–30
  opening 32
  sending to West Case Notebook
    from Microsoft Outlook 31–32
    using Windows Explorer 30–31
  transferring text 80
Portable Transcript (PTF) files 20
potential exhibits, inserting into outlines 56–57
PowerPoint presentations 91
printing
  outlines 61–62
  transcript with annotations 17–18
  prioritizing issues 64–66

Q
Quick Marks
  deleting 87
  folder 87
  inserting 87
  jumping to 87
  reports 88–89
quotation marks 75

R
RealLegal Binder cases, opening 4
Realtime
  accessing
    through Internet Explorer 85
    through West Case Notebook 85
  inserting
    Issue Marks 89
    Quick Marks 87
Internet connection 84–86
LiveNote Stream 84–86
Quick Marks report 88–89
serial connection 84
starting text 87
stopping text 87
remote access to cases 6
replicating
  individual case
    offline 7–8
    to the network 8
  multiple cases
    offline 8–9
    to the network 10
replication options, changing 10
reports
  annotations 70–72
  attachments 72
  Auto Tag 77
  case 11–12
  characters 52–53
  data groups 79
  inserting into outlines 55–56
  issues 66–67
  key facts 44–45
  notes 72
  Quick Marks 88–89
  search 75
  transcript summaries 16
  verbatim digest 72
research
  sending to West Case Notebook
    using Windows Explorer 40–41
root expander (!) 74

S
saving
  key facts as West Case Timeline file 46
  Microsoft PowerPoint presentations 91
searching
  on Westlaw 33–34
  on WestlawNext 37–38
  using data groups 79
search reports 75
secure cases
  accessing 4–6
  favorite 7
sending
  annotations to instant messages 70
  documents to West Case Notebook
    from Microsoft Outlook 27–28
    using Windows Explorer 26
key facts to
  Corel WordPerfect 45
  Microsoft Word 45
  West Case Timeline 45–46
pleadings to West Case Notebook
  from Microsoft Outlook 31–32
  using Windows Explorer 30–31
research to West Case Notebook
  using Windows Explorer 40–41
serial connection to Realtime 84
smart tags
  about 49
  adding
    manually 50
sorting by data groups 79
starting text in Realtime 87
stopping text in Realtime 87
sub-issues, creating 64–65
summarizing transcripts 14–16

T
transcripts
  closing 16
  deleting 17
importing
  file types 1
  individual files 13
  opening 14
printing with annotations 17–18
questions, inserting into outlines 57–58
summaries
  creating 14–16
  deleting 16
  opening 16
transferring text 80
updating
  about 19
  ASCII file 19
  E-Transcript (PTX or EXE) file 19
  LiveNote Evidence Format (LEF) file 20–21
  Portable Transcript (PTF) file 20
transcript summaries
  creating 14–16
  deleting 16
  opening 16
  report 16
transferring
  annotations 69, 90
  document text 80
  pleading text 80
  transcript text 80
  video segments 90
  Westlaw document text with citation 81
  TrialDirector, transferring annotations to 69

U
universal character (*) 74
updating transcripts
  about 19
  ASCII file 19
  E-Transcript (PTX or EXE) file 19
  LiveNote Evidence Format (LEF) file 20–21
Portable Transcript (PTF) file 20

V
verbatim digest report 72
video segments
  creating from annotations 90
  playing 90
  transferring to Microsoft PowerPoint 91
viewing documents in outlines 61

W
West Case Timeline
  saving key facts as TAB file 46
  sending key facts to 45–46
WestFind&Print 35
WestlawNext research
  exporting 39
  searching 37–38
  sending to West Case Notebook 39
Westlaw research
  exporting 35
  importing documents 41–42
  inserting into outlines 58–61
  KeyCite 40
  retrieving character profiles 51–52
  searching 33–34
  sending to West Case Notebook 35
  transferring document text 81
  WestFind&Print 35
West LiveNote RAS (remote access server) 6
Windows Explorer
  sending documents 26
  sending pleadings 30–31
  sending research 40–41
Windows Media Player 84
Word Index
  about 82
  display options 82
WordPerfect
  exporting key facts to 45
  transferring annotations to 69